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The RMTrak User Manual will guide you through working with RMTrak and will demonstrate the 
power and simplicity of the RMTrak system. It follows the steps outlined in the Step-By-Step 
Guide.  
 
RBC Product Development is dedicated to making you a successful, satisfied customer. If you 
have any questions or issues these files cannot answer, please do not hesitate to contact RBC 
Product Development  

 

Navigation 

Navigate from one topic to the next using the forward and backward buttons at the top of the 
tutorial window. These buttons will take your forward and backward within the predefined 
sequence of tutorial topics.  

 

 
Forward and  

Backward buttons 
 

Additionally, this tutorial includes icons that point to related information. 

You can begin the tutorial here. 

 

Links 

This text in each topic has links to other topics (as you'll see above). Feel free to use these 
links to browse through related material. When you're done, you can use the Back button at 
the top of the tutorial window to go back to the original page you were on; you can then 
continue browsing the tutorial using the Continue section at the bottom of the page. 

 

Warnings 

This tutorial uses this icon to help you find information: 

 

 This icon will direct you to warnings and important information. Be sure to read information beside 
this icon. 
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 Sample Databases 
 

The tutorial and RMTrak's sample files are based on a fictitious product called the 
Revolutionary Automated Teller Machine (RATM).  
 

All of the documents and files used in this tutorial can be found in the C:\Program 
Files\RBC\RMTrak\Sample directory if RMTrak was installed to the default location, or in the 
<Drive:\Path>\Sample directory, where <Drive:\Path> is the mapped disk drive and folder path 
where RMTrak was installed.  
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Getting Help 
 

The RMTrak Online Help System that is included with RMTrak contains additional information 
about all of the topics covered in this tutorial. The Online Help System is available through 
RMTrak from the Help menu or by pressing F1 at any RMTrak window or dialog. 
 
RBC Product Development is dedicated to making you a successful, satisfied customer. If you 
have any questions, comments, or suggestions regarding RMTrak, please do not hesitate to 
contact us: 
 

 
 
RMTrak@rbccorp.com (general inquiries) 
RMTrak.support@rbccorp.com (support) 
www.RMTrak.com  
 

 
Please check the RMTrak web site for updates or additions to RMTrak, its help files, and its 
tutorial: www.RMTrak.com  
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RMTrak is a tagging, tracing, allocation, and verification system, also known as a "requirements 
management tool," developed by RBC Product Development. If you have any questions, 
comments, or suggestions, please contact RBC Product Development   
 
RMTrak was designed for product development companies but can easily be configured for any 
other type of company needing to tag, trace, allocate, and verify project requirements. 
 
 
Requirements Management Tools 
 
Product development companies frequently deal with requirements management: Clients, 
developers, and industry standards determine the many requirements necessary to complete a 
project. The product development company then needs to keep track of each requirement and 
when it's been successfully implemented and tested. Since large projects can have thousands of 
requirements, this is often a difficult and tedious chore. Requirement management tools provide a 
way to track your project's requirements and when each one's been completed. 
 
RMTrak is a requirements management tool designed for beginner and advanced users alike; it 
allows you to manage your development project's requirements and generate different kinds of 
views and reports, depending on your needs. It also lets you keep track of whether your 
requirements passed or failed required tests.  
 
Unlike other requirements management tools, RMTrak was designed with two primary features in 
mind: allowing its users to create their documents as they usually do while adjusting to their 
needs, and to keep important information in the documents themselves. Rather than require you 
to tag or create documents that conform to a standard, RMTrak is flexible and lets you configure 
your RMTrak project to match the information you'll be adding to it. The only difference is that 
your documents will now include tags—and their purpose is to mark the most important 
information within the documents. Because all of the relevant information is stored in the 
documents, you'll never have to worry about a database becoming corrupt or about losing your 
RMTrak database files. Recreating a RMTrak database is a cinch because it gets its information 
from the tags in your documents.  
 
The tags you add to your documents are easy to create and, unlike other requirements 
management tools, RMTrak doesn't force you to make them a certain way: Although the tutorials, 
samples, and online help files offer suggestions, there's limitless different ways to format your 
tags and their syntax because RMTrak is highly configurable. 
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How It Works 
 
RMTrak works with your companies' product development documentation (created in Microsoft® 
Word) with one adjustment: adding tags around each requirement listed in your documentation. 
With each document you create, you'll need to add tags around the individual 
requirements/tests—this will later allow RMTrak to recognize these items as traceable 
requirements. Because you can put tags in any chosen Microsoft® Word style, you can easily 
make these tags invisible to uninterested readers.  
 
As you create documents with tagged requirements, you'll import them into RMTrak, which will 
load the requirements into a database from which you can generate reports based on the tags 
and their status. This way, you can generate reports based on which items successfully passed 
their tests and which requirements have been fulfilled for the project. As you continue to maintain 
the documents using Microsoft® Word and to manage their requirements using RMTrak, you'll 
continue to get a vivid picture of how your requirements stand and how your project is 
progressing. 
 
 
What You Need to Know 
 
If you’re an executive or administrator who needs to use RMTrak to print reports or save views, 
you'll only need to know how to use RMTrak. This online help system and the RMTrak Getting 
Started Tutorial can help you.  
 
If you or your project management team is creating the database and documents for your 
RMTrak project, you’ll need to know these things: 
 
• You’ll need to know how to use Microsoft® Word for creating your documents. The Working 

with Microsoft® Word topic gives an overview of some handy features that will help you get 
the most out of the documents you import into RMTrak. 

 
• Although RMTrak can be used to manage requirements for any type of project, it was 

especially developed for product development companies. Familiarity with product 
development and a defined product development process will be helpful if you want to use 
the default document types and attributes. 
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Document Design 
 
To save time, you should consider using templates for each of your document types. Templates 
are documents that have been saved as a .dot file. Depending on your document's purpose, the 
templates' design and formatting might vary.  
 
RBC Product Development recommends that each document follow a standard format, including 
an introduction, body and conclusion. A table of contents is also advisable for all documents, as it 
will allow your readers to see the topics covered by the document at a glance.  
 
Additionally, you'll notice that the sample files included with RMTrak's installation each use a 
standard format. Although you do not need to copy these formats, if you are new to requirements 
management, you might find them helpful as templates. To use these documents as templates, 
re-save them with a .dot extension to your requirements management directory. 
 
The opening section of a well-designed requirements management document should include: 
 
• Purpose of the document (its message and contents) 

 
• List of references (other documents referred to within the body of this document)—this 

establishes a link to other sources of information 
 

• Table of revision history (the changes to the document should be recorded in this table, 
including revision number, description of revision, date revised and author of the revision) 
 

• Any document-specific information (marketing analysis, pricing models, regulations required, 
financial targets, etc.) 
 

• Definitions of the requirement tags that will be used in the document (give the words used 
with the project and document acronyms) and the definitions of any attributes that are related 
to the requirements included in the document. 

 
The body of the document should be used for listing the requirements and their supporting 
information. Due to the flexibility of RMTrak, this text can be formatted in a way you prefer, such 
as in tables or regular text.  
 
The conclusion of the document should include any notes or interpretations that should be drawn 
from the document. It is often useful to include any thoughts or notes that pertain to a document 
so they can be referenced during the project to fully understand and evaluate the decisions that 
were made as the project progressed.  
 
The headers and footers of your documents can include company and product specific 
information. This could save time and confusion later. The sample files provided with RMTrak 
show headers and footers that might be helpful.  
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Document Hierarchy 
 
Documents are usually ordered so requirements from one document flow down into the next 
document. With each lower layer, the information can become more detailed and specific.  
 
One possible hierarchy is shown below. This particular hierarchy can be used in a regulated 
environment, such as Medical Device Design. This hierarchy reflects RMTrak's default document 
types and their terminal status. 
 

  
 

 
As you create requirements and add their tags, RMTrak will recognize their relationship.  
 
You'll have to tell RMTrak which documents are terminal by specifying this in the Document 
Types manager. This will become especially important when creating Childless Reports to 
determine which requirements you've neglected or forgotten. 
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Parent-Child Relationships 
 

The first document of your project may list many requirements. These requirements can go on 
to create many other requirements over the course of the project, and these requirements will 
be listed in subsequent documents.  

 

Additionally, requirements will have their status updated in each relevant document. As a 
requirement's status is updated in each document, the next document's status of that "child" 
requirement is traced back to its previous document's predecessor, or "parent" requirement. In 
this way, requirements and their status have parent-child relationships.  

 

And just like typical parents and children, a parent or child will have different roles to those 
around it—a requirement can be both a parent (to those that come after it) and a child (to those 
that come before it). 

 
The following flow chart shows the relationship of some parent and child requirements. For 
example, RATM:CRD:1 is a parent to the RATM:PRD:1 child requirement. RATM:VTR:2 is a child 
tag to the RATM:PRD:2 requirement. 
 

  
 

 

� Note: This example only shows only a few requirements—in reality, this chart might include hundreds or more 
requirements. Also, the organization of these documents and their requirements might not be similar for your 
projects. Finally, notice that the PRD and VTP have initial tags only and do not come from parent tags in 
previous documents. 

 

With RMTrak, as you create each new document, you'll need to place a tag in front of each 
requirement to show its position in the current document. You can also place a "parent tag" after 
it to show which requirement it originated from. Doing this allows you to trace requirements 
upward to the requirement that created this one. 

 
In the following example, RATM:VTR:1 is the child requirement and [RATM:PRD:1] is the parent 
requirement: 
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RATM:VTR:1 The circuit shall be interrupted when the ground is  
shorted. {Test Method = I}[RATM:PRD:1]¶ 
 

Parent tags will always be surrounded by brackets [ ]. 

 

� Note: The sample above shows similar numbers tracing down in requirements. For example: 

 

RATM:CRD:1 à RATM:PRD:1 à RATM:VTR:1 

 

(The arrows show the direction of the parent-child relationship.) 
 

In reality, these numbers might be different. It’s possible to have a parent-child relationship of different 
numbers, depending on how you numbered each document's project requirements. For example: 

 

RATM:CRD: 3 à RATM:PRD: 25 à RATM:VTR: 16 

 
 
For information on how documents relate to each other, see the Document Hierarchy topic. 
 
 
Childless Requirements 
 
A childless requirement is a parent requirement that has no children requirements created from it.  
 
For information on childless requirements, see the Childless Requirements topic. 
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Step-By-Step Guide 
 
Basic use of RMTrak follows these steps: 

 
1. Create a new database or open an existing database. 

 
2. If desired, customize the project's default setup. 

 
3. Create or edit your document in Microsoft® Word using tags. 

 
Be sure to: 
 

• Write tags using appropriate syntax. 
 

• Format tags to be either red and bold or to have the Microsoft® Word style you chose in RMTrak's 
tags setup. 

• Format tags to end with either a paragraph mark or with the character you designated in RMTrak's 
requirements termination setup. 
 

i Tip: Paragraph marks (¶), which are created by pressing ENTER on the keyboard, are also 

called "hard carriage returns." Line breaks ( ), which are created by pressing 
SHIFT+ENTER, are also called "soft carriage returns." 
 

• If applicable, put the document number and revision number in either the document's 
properties or in the filename, depending on RMTrak's documents setup. 
 

4. If your document's type is not listed in the Document Types manager, you'll need to add 
it. 
 

5. Import the document to your RMTrak project. 
 

6. Repeat steps 3 – 5 as needed. 
 

7. You can view the project's requirements, allocation, and tracing in a number of different 
ways according to your needs.  
 

8. You can generate reports for the documents according to your needs.  
 
As you modify your documents, you'll need to edit their document properties or refresh the 
document. 
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Working In the Main  
Documents Manager 
 
Whether you create a new database or open an existing one, the main window you'll work from is 
the Documents manager. 
 

 
Documents manager 

 
 
The documents that have been imported into the database are alphabetically listed (by document 
title) in this window. RMTrak constantly scans the documents to see which are out of date, but 
does this slowly so it does not cause you any problems 
 
The documents in the list are divided in two ways: 
 

Documents 
 

This is the name of the document. You can specify a name from 
the Modify Document Dialog or by specifying it in the document's 
properties. 
 

Type 
 

This is the document type. Document types can be associated 
with a document from the Modify Document dialog available from 
the Properties button. Document types are determined in the 
Document Types manager available from the Setup menu. 
 

 
Additionally, if RMTrak has been set up to recognize document numbers or revisions, these will 
also be shown. 
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The Document manager allows you to add, delete, refresh, open, and edit document properties 
by clicking on a document in the list then clicking its corresponding button: 
 

New Opens the New Document dialog and starts the process of adding 
a new document to the database 
 

Delete Deletes a selected document from the database. This action will 
delete all records associated with the document.  
 

Refresh Updates the database's information with information from the 
document.  
 

Open Opens the document in Microsoft® Word. Double-clicking the 
document in the Documents manager list will also perform this 
action.)  
 

Properties Opens the Modify Document dialog and allows you to modify the 
document's Title, Path and Type, while the Number, and 
Revision fields are read-only (to change the Number, or Revision, 
you'll need to re-import the document). 
 

 

 Warning: If you click the Delete button, the document's information will be removed from your RMTrak 
database. 
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Maximizing the Documents Manager Window 
 
When you start RMTrak, the Documents Manager only fills part of the RMTrak window.  
 

 
Documents Manager 

 
 

If you have long document names, or many documents, you might find it helpful to maximize the 
window to fill the entire screen. Click the Maximize button in the upper right corner of the 
Documents Manager. This will make the Documents Manager fill the entire RMTrak window. 
 

 
Documents Manager Maximized 

 
 

If the window is not maximized, you can also adjust its size by clicking its lower right corner and 
dragging it to the desired height and width. 
 
You can also adjust the width of the Documents and Type column headers. 
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Column Headers 
 
When you open the Documents Manager, there are initially two adjustable column headers, 
Documents and Type. 
 

 
Documents Manager 

 
 

Documents 
 

This is the name of the document. You can specify a name when 
you import the document or RMTrak can recognize it from your 
document's properties. 
 

Type 
 

This is the document type. Document types are set when a 
document is first imported into the database. They can also be set 
from within the Modify Document Dialog, which is available from 
the Properties button.  
 
Document types can be configured from within the Document 
Types manager, which is available from the Setup menu. 

 
If you have configured RMTrak's Documents Setup to recognize numbers, sliding the left side of 
the Type column header to the right will review another column header: Number.  
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Documents Manager with Number Column Header 

 
 

Number 
 

This is the number of the document. RMTrak will recognize the 
document's number from the document's filename or properties, 
depending on how you configured RMTrak's Documents Setup. 

 
 
You can adjust the width of these column headers by clicking on the edge of a column header 
and dragging it to the width you prefer.  
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Creating Databases 
 
Creating a database is the first step to working with a new project in RMTrak. RMTrak uses the 
database to store the requirements tagged within the Documents you'll add to your project.  
 
To create a new database in RMTrak, from the File menu, click New. This will start the New 
Database Wizard.  
 

 
New Database Wizard 

 
 
The first part of the New Database Wizard allows you to select a location to save the file: 
 

1. Click Browse.  
 

2. Select the folder on your computer you want to save the new database to, then type a 
name.  
If the database is to be shared by more than one person, it is recommended that the 
database be stored on a network drive that is accessible to all users.  
 

  Warning: RMTrak currently cannot support multiple simultaneous users. This means that only one 
person at a time can have the project open within RMTrak. 

 
3. When you are finished, click Open.  

The New Database Wizard will reappear with the location of the file you selected.  
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New Database Wizard 

 
4. Click Next. 

 
The next part of the New Database Wizard allows you to select a method of creating the 
database.  
 

 
New Database Wizard 

 
 
You have three choices:  
 

New (Default)  This option allows you to create a new database with 
the default settings: tags recognized as any red and 
bold text, requirements terminated by paragraph 
marks (¶), and document numbers and revisions 
disabled. 

i  Tip: Paragraph marks (¶), which are created by pressing 
ENTER on the keyboard, are also called "hard carriage 

returns." Line breaks ( ), which are created by pressing 
SHIFT+ENTER, are also called "soft carriage returns." 
 

New (Custom)  This option allows you to create a new database with 
your own customized settings. 
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Import a Rational 
RequisitePro® 
Database  

This option allows you to import a Rational 
RequisitePro® database. 

 
 
The New Database Wizard will change to reflect the database type you choose. The next three 
sections of the tutorial will detail each of these options. 
 

Creating New (Default) Databases 
 
To create a new database in RMTrak that uses default settings, from the File menu, click New. 
This will start the New Database Wizard.  
 

 
New Database Wizard 

 
 

1. Click Browse.  
 

2. Select the folder on your computer you want to save the new database to, then type a 
name.  
 
If the database is to be shared by more than one person, it is recommended that the 
database be stored on a network drive that is accessible to all users.  
 

 

 Warning: RMTrak currently cannot support multiple simultaneous users. This means that only one 
person at a time can have the project open within RMTrak. 

 
 

3. When you are finished, click Open.  
The New Database Wizard will reappear with the location of the file you selected.  
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New Database Wizard 

 
 
4. Click Next. 

The New Database Wizard will ask you to select a method for creating the new database. 
 

 
New Database Wizard 

 
 

5. Choose New (Default) then click Next. 
RMTrak will create your database at the file location you selected and immediately open 
it for you. 
 
 

You can customize this database's settings at any time by using RMTrak's Setup menu. 
 

� Note: When you choose to create a default database, the documents you add to the database will need to 
have tags that are red and bold and have paragraph marks (¶) after them. Document numbers and revisions 
should be stored in the document file name; the format for filenames must be NNNNNNrevR.R.doc, where 
NNNNNN represents the document number, rev represents the abbreviation for "revision," R.R represents the 
revision number (which can be done in pointed increments or whole numbers), and .doc represents the 
Microsoft® Word file extension. The version and revision numbers can be any whole number or integer that 
does not contain spaces. For example, 3486rev3.4.1.doc and 112386rev21.4 are both valid file names. 
 

i Tip: Paragraph marks (¶), which are created by pressing ENTER on the keyboard, are also called "hard 

carriage returns." Line breaks ( ), which are created by pressing SHIFT+ENTER, are also called "soft 
carriage returns." 
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If you want to change the default settings for this project, you may do so now. Otherwise, you can 
begin working with documents for this project. 
 

Creating New (Custom) Databases 
 
To create a new database in RMTrak that uses your own customized settings, from the File 
menu, click New. This will start the New Database Wizard.  
 

 
New Database Wizard 

 
 
Step 1: Select a file location: 
The first two parts of the New Database Wizard allow you to specify a file location and to choose 
to create a new, customized database: 
 

1. Click Browse.  
 

2. Select the folder on your computer you want to save the new database to, then type a 
name.  
If the database is to be shared by more than one person, it is recommended that the 
database be stored on a network drive that is accessible to all users.  
 

 Warning: RMTrak currently cannot support multiple simultaneous users. This means that only one 
person at a time can have the project open within RMTrak. 

 
 

3. When you are finished, click Open.  
The New Database Wizard will reappear with the location of the file you selected.   
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New Database Wizard 

 
4. Click Next. 

The New Database Wizard will ask you to select a method for creating the new database. 
 

 
New Database Wizard 

 
 

5. Choose New (Custom) then click Next. 
 
 

Step 2: Specify a tagging and tracing option: 
The next part of the New Database Wizard allows you to specify how tagging and tracing 
information will be identified.  
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New Database Wizard 

 
 
You have two choices: 
 

Red/Bold Text This option will set up RMTrak to recognize tags within your 
Documents as being any text that is both red and bold.  
 

Microsoft® Word 
Style 

This option will set up RMTrak to recognize tags within your 
Documents as being formatted in a specific Microsoft® 
Word style. (Microsoft® Word allows you to format text to 
have "styles," such as Body Text, Heading 1, Heading 2, 
and customized styles.) 
 

 
Select either the Red/Bold or Microsoft® Word Style option. If you choose Microsoft® Word 
Style, a dialog box will appear. Type the name of the Microsoft® Word style exactly as it appears 
in Microsoft® Word. When you are finished, click Next. 
 
Step 3: Specify a requirements termination option: 
Specify how requirement text will be terminated.  
 

 
New Database Wizard 

 
 
You have two choices: 
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First hard carriage 
return following tag 

This option specifies that the tags in your documents 
will each end with a paragraph mark (¶).  
 

i Tip: Paragraph marks (¶), which are created by pressing 
ENTER on the keyboard, are also called "hard carriage 

returns." Line breaks ( ), which are created by 
pressing SHIFT+ENTER, are also called "soft carriage 
returns." 
 

First occurrence of ___ 
following tag 

This option specifies that the tags in your document 
will each end with a specific character of your choice 
(where ___ represents the specific character).  
 

 
Select either the First hard carriage return following tag or First occurrence of ___ following 
tag option. If you choose the latter option, you will need to type in the space provided the 
character exactly as it will appear in your documents.  
 
If you need help choosing a character, you can click the Char Map button to bring up the 
Microsoft® Windows® character map. When you are finished, click Next. 
 
Step 4: Specify a document number option: 
Specify how the document number will be determined.  
 

 
New Database Wizard 

 
 
You have three options:  
 

Do not use document 
numbers 
 

This option specifies that you will not track document 
numbers. 
 

Document number 
stored in an Microsoft® 
Word document 
property 
 

This option specifies that you will place document 
numbers in a customized property in Microsoft® 
Word's document Properties listings.  
 

Document number is 
stored in the filename 
(NNNNNNrevR.R.doc) 

This option specifies that you will place document 
numbers in the filename. If you want to specify 
document numbers in the filename, the format must 
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be NNNNNNrevR.R.doc, where NNNNNN 
represents the document number, rev represents the 
abbreviation for "revision," R.R represents the 
revision number (which can be done in pointed 
increments or whole numbers), and .doc represents 
the Microsoft® Word file extension. 
 

� Note: The version and revision numbers can be any 
whole number or integer that does not contain spaces. 
For example, 3486rev3.4.1.doc and 112386rev21.4 are 
both valid file names. 

 
 
Select one of the above options. If you choose Document number stored in an Microsoft® 
Word document property, you will need to type in the space provided the custom name of the 
Microsoft® Word property exactly as it will appear in the Microsoft® document Properties listings 
for your documents. When you are finished, click Next. 
 
Step 5: Specify a document revision option: 
Specify how the document revision will be determined.  
 

 
New Database Wizard 

 
 
You have three options: 
 

Do not use document 
revision 
 

This option specifies that you will not track 
document revisions. 
 

Document revision 
stored in a Microsoft® 
Word document property 
 

This option specifies that you will place document 
revisions in a customized property in Microsoft® 
Word's document Properties listings.  
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Document revision is 
stored in the filename 
(NNNNNNrevR.R.doc) 

This option specifies that you will place document 
revisions in the filename. If you want to specify 
document revisions in the filename, the format 
must be NNNNNNrevR.R.doc, where NNNNNN 
represents the document number, rev represents 
the abbreviation for "revision," R.R represents the 
revision number (which can be done in pointed 
increments or whole numbers), and .doc 
represents the Microsoft® Word file extension. 
 
�  Note: The version and revision numbers can be any 

whole number or integer that does not contain spaces. 
For example, 3486rev3.4.1.doc and 112386rev21.4 are 
both valid file names. 

 
 
Select one of the above options. If you choose Document revision stored in an Microsoft® 
Word document property, you will need to type in the space provided the custom name of the 
Microsoft® Word property exactly as it will appear in the Microsoft® Word document Properties 
listings for your documents. When you are finished, click Next. 
 
Step 6: Select default document types: 
Select which of RMTrak's default document types you want to use.  
 

 
New Database Wizard 

 
 
Place a checkmark by the types of documents you will be creating for this project. If you will not 
be creating any of these documents, uncheck each default document type. (You can later create 
your own document types from RMTrak's Define Document Types option in the setup menu.) 
When you are finished, click Next. 
 
Step 7: Select default attributes: 
Select which of RMTrak's default attributes you want to use.  
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New Database Wizard 

 
 
Place a checkmark by the types of attributes you will be using for this project. If you will not be 
using any of these attributes, uncheck each default attribute type. (You can later create your own 
attribute types from RMTrak's Define Attribute Types option in the setup menu.) When you are 
finished, click Next. 
 
You're Finished! 
RMTrak will create your database at the file location you selected and immediately open it for 
you. You can customize this database's settings at any time by using RMTrak's Setup menu. 
 
 
Once you've created your database, you're ready to begin adding documents to it. 
 

 

Importing Rational RequisitePro® Databases 
 
To create a new database in RMTrak that uses default settings, from the File menu, click New. 
This will start the New Database Wizard.   
 

 
New Database Wizard 
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1. Click the Browse button.  
 

2. Select the folder on your computer you want to save the new database to, then type a 
name.  
 
If the database is to be shared by more than one person, it is recommended that the 
database be stored on a network drive that is accessible to all users.  
 

 Warning: RMTrak currently cannot support multiple simultaneous users. This means that only one 
person at a time can have the project open within RMTrak. 

 
 

3. When you are finished, click Open.  
The New Database Wizard will reappear with the location of the file you selected.   
 

 
New Database Wizard 

 
 
4. Click Next. 

The New Database Wizard will ask you to select a method for creating the new database. 
 

 
New Database Wizard 
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5. Choose Import a Rational RequisitePro® Database then click Next. 
You will be asked to select the Rational RequisitePro® database located on your 
computer. 
 

6. Click the Browse button.  
 

7. Locate the Rational RequisitePro® database then click Open. 
The New Database Wizard will reappear with the location of the file you selected.  
 

8. Click Next. 
The Rational RequisitePro® Import Utility will import the database's information into a 
new RMTrak database. 
 

9. RMTrak might require further steps before it can import your project. Follow the directions 
on the screen to complete any further steps. If you need additional help, please contact 
RBC Product Development  
 

RMTrak builds the database from the settings of your Rational RequisitePro® database. If you 
want to change the settings for this project, you may do so after RMTrak has opened the 
database. Otherwise, you can begin working with documents for this project. 
 
 

Opening Existing Databases 
 
To open an existing database from within RMTrak: 
 

1. From the File menu, choose Open.  
 

2. Browse to find the location of your file, then click Open.  
RMTrak will open the database. 
 

 Warning: RMTrak currently cannot support multiple simultaneous users. This means that only one 
person at a time can have the project open within RMTrak. 

 
 

You can also open RMTrak by double-clicking your project’s .tra database file located on your 
computer or server. 
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Changing Project Setup 
Options 
 
You can change the settings of your project at any time.  
 
Setup options are available from the Setup menu: 
 

Attributes You can insert attributes into your documents to assign information 
to a requirement. The setup option for attributes allows you to 
customize which attributes are allowed. 
 

Document 
Types 

Depending on your purpose for using RMTrak, you might be using 
different types of documents. RMTrak's default document types 
are set up with the names of typical product development 
documents. By keeping RMTrak's list of document types accurate, 
you ensure that the information RMTrak provides you in its views 
and reports are meaningful and beneficial to you. 
 

Tag 
Filters 

To allow more than one project to share documents, RMTrak has a 
tag filter to allow you to keep tag and requirements that belong to 
another project from entering the database.  
 
If the tag filter is set to recognize a type of tag, only requirements 
matching the tag type will be loaded into the project database. 
 
RMTrak's default settings do not have any tag filters. 
 

Options RMTrak lets you adjust the formatting/identification and 
requirements termination of tags, as well as the document and 
revision numbering, of your project at any time. The initial settings 
are determined when you originally created the database. 
 

 
The options you set up for the project will affect all of your project's documents. 
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Defining Attributes 
 
Attributes are used to specify information about a requirement. By adding attributes to your tags, 
you can trace requirements' information, such as implementors, test dates, and test status.  
 
RMTrak's default attributes include attributes common to product development requirements. 
These default attributes can be added to, edited, or deleted at any time using the Attributes 
Manager available from the Setup menu. If your company wants to add attributes such as risk, 
cost, importance, etc., RMTrak lets you do this easily. 
 
Default attributes: 
 

Implementor 
Type: Enum (Multiple) 
Rule: HW;SW;QA 
This attribute can be used to show that the requirement's Implementor is one or more of the 
Hardware, Software, and/or Quality Assurance divisions within the company. This attribute is 
especially helpful for tags within Software Requirement Specifications. To avoid repetitive 
typing, these values have been given acronyms.  
 
Test Date  
Type: Date 
This attribute can be used to show the requirement's test date. This attribute is especially 
helpful for tags within test requirement documentation.  
 
Test Method 
Type: Enum (Single) 
Rule: I;A;D;T 
This attribute can be used to show that the requirement's test method is either Inspection, 
Analysis, Detection, or Test, which are common product development test methods. This 
attribute is especially helpful for tags within test requirement documentation. To avoid 
repetitive typing, these values have been given acronyms.  
 
Test Status 
Type: Boolean 
This attribute can be used to show that the requirement's test status is either T (for 
True/Passed) or F (for False/Failed). RMTrak marks passed requirements as "closed" for its 
reports and views. This attribute is especially helpful for tags within test requirement 
documentation. To avoid repetitive typing, these values have been given acronyms.  
 
Tester 
Type: Enum (Single) 
Rule: HW;SW;QA  
This attribute can be used to show that the requirement's tester is either the Hardware, 
Software, or Quality Assurance division within the company. This attribute is especially 
helpful for tags within test requirement documentation. To avoid repetitive typing, these 
values have been given acronyms.  
 

 
Define Attributes 
 
To define attributes, use the Attributes manager available from the Setup menu. 
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Attributes manager 

 
 
The Attributes manager allows you to add, edit, and delete attributes by clicking an attribute in the 
list then clicking its corresponding button: 
 

New Opens the Attribute Edit dialog so you can add an attribute to the 
list. 
 

Delete Deletes the attribute from the database. 
 

Properties Opens the Attribute Edit dialog so you can edit an attribute (i.e. 
Name, Type, Rule, etc.) of an attribute. 
 

Done Closes the Attributes manager. 
 

 
If you click the New or Properties button, the Attributes Edit dialog will appear. 
 

 
Attributes Edit dialog 

 
 
The Attribute Edit dialog has these fields: 

 
 

Name  This is the name of the attribute, which appears whenever the 
attribute is referenced. Attribute names are limited to 50 
characters. 
 

Type This is the data type of the attribute. For more information about 
data types, see the Attributes' Data Types and Rules Syntax topic 
available from RMTrak's Help menu. 
 



 RMTrak™ Requirements Management Tool User Manual © 2002 RBC Product Development http://www.RMTrak.com 33 

 
Rule This is the rule used to validate the value assigned to an attribute. 

The application makes sure that only valid values are assigned to 
an attribute. You'll only need to specify a rule if you've selected 
Enum (Single) or Enum (Multiple) from the data Type drop-
down list. For more information about rules, see the Attributes' 
Data Types and Rules Syntax topic available from RMTrak's Help 
menu. Attribute rules are limited to 200 characters. 
 

Persistent This check box determines whether the attribute is persistent. 
Persistent attributes are stored in the database, whereas non-
persistent attributes are stored in the document. If the Persistent 
check box is checked for an attribute, the attribute's values can be 
assigned to requirements from within RMTrak's Allocation view. 
This eliminates the need to specify the attribute in your 
documents' tags.  
  

 

 Warning: If you use Persistent attributes, you might want to periodically save your database to a 
different name (leaving the previous named version as a "backup" copy). Otherwise, should you lose 
the database, the information you stored in it would also be lost. If you want to retain RMTrak's 
document-centric benefit of leaving important information in the documents rather than in the 
database, do not use persistent attributes. 

 
 
Applying Attributes to Requirements 
 
See the Applying Attributes to Requirements topic. 
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Defining Document Types 
 
Depending on your company's needs, you might use many different types of documents with 
RMTrak. You can apply a document type to your document by using the Modify Document dialog, 
available by clicking the Properties button in the main Document manager. 
 
Default Document Types 
 
RMTrak's default document types include those common to product development. These default 
document types can be added to, edited, or deleted at any time using the Document Types 
manager available from the Setup menu. By keeping RMTrak's list of document types accurate, 
you ensure that the information RMTrak provides you in its views and reports are meaningful and 
beneficial to you. 
 
Default document types included with RMTrak's default installation: 
 

• Customer Requirements Document 
• Hardware Design Description 
• Hardware Requirements Specification 
• Hardware Verification Test Procedure (Terminal) 
• Product Requirements Document 
• Product Validation Test Procedure (Terminal) 
• Software Design Description 
• Software Requirements Specification 
• Software Verification Test Procedure (Terminal) 
• System Hazard Analysis 

 
The diagram below shows a standard hierarchy of documents that includes these document 
types. Your own hierarchy might differ from this one. 
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Define Document Types 
 
You can add, edit or delete RMTrak's default document types at any time.  
 
To define document types, use the Document Types manager available from the Setup menu.  
 

 
Document Types manager 
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The Document Types manager allows you to add, edit, and delete document types by clicking a 
document type in the list then clicking its corresponding button: 
 

New Opens the Define Document Type dialog so you can add a 
document type. 
 

Delete Deletes the document type. 
 

Properties Opens the Edit Document Type dialog so you can edit the 
properties (i.e. name, corresponding attributes, etc.) of a document 
type. 
 

Done Closes the Document Types manager. 
 

 

� Note: If your document types have long names and are cut off on the right side of the window, you can 
adjust the size of the window by dragging the lower right corner of the Document Types manager to the 
desired length and width 

 
Adding or editing document types will affect the list of document types available from the 
Document Types manager.  
 
If you click the New or Properties button in the Document Types manager, which is available 
from the Setup menu, the Define Document Type dialog or Edit Document Type dialog appears. 
 

 
Define Document Type dialog 
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Edit Document Type dialog 

 
 

� Note: In the Default Attributes area of the Define Document Type Dialog and the Edit Document Type dialog, 
the left side shows available attributes; the right side shows attributes selected for this document type. 

 
The Define Document Type dialog and Edit Document Type dialog have these fields: 
 

Name  This is the name of the document type. Document type names are 
limited to 50 characters and may include spaces. 
 

Default 
Attributes 
 

These are the default attributes available for this document type.  
 
The list in the left pane shows the default attributes for this 
document type. The list in the right pane shows the list of available 
attributes.  
 
This list can be modified from the Attributes manager.  
 

Terminal This check box shows whether the document type is the final, 
terminal document in your document hierarchy. 
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Defining the Tag Filter 
 
To allow more than one project to share documents, RMTrak has a tag filter. The tag filter allows 
you to keep tags and requirements that belong to another project from entering the database. The 
tag filter works similarly to a search string in a word processor. RMTrak's default settings do not 
have any tag filters. 
 
Thanks to RMTrak’s tag filter, it’s easy to list requirements of different projects within the same 
document, and yet not have them be confused in reports and views. RMTrak’s tag filter allows 
each project to only recognize document tags that were intended for it, ignoring any tags intended 
for another project. This lets you use a document for more than one project without hassle or 
confusion. 
 
 
How It Works 
 
When you import a document into the Documents Manager that has tags around its 
requirements, RMTrak, by default, imports all of the requirements tagged within the document. If 
you use documents for more than one project, this could confuse your views and reports with 
information from two projects. By adding tags to the tag filter, you're telling RMTrak which tags 
are intended for this project so RMTrak knows to ignore all others.  
 
For example, a document could have information about separate products. In the below example, 
a project called the Revolutionary Automated Teller Machine (RATM) has three divisions: RATMN 
(RATM Network), RATM (the machine), and RATMW (RATM Wireless). Both the RATMN and the 
RATMW includes the RATM requirements, but the RATMN and RATMW have separate 
requirements. In the document, this can be shown as follows: 
 

Requirements for the RATM: 
 RATM:PRD:1 The system will dispense money. 
 RATM:PRD:2 The system will use encryption when  

transferring PINs. 
  

Additional requirements for the wireless system only: 
 RATMW:PRD:3 The system will have wireless access. 

  
Additional requirements for the network system only: 
 RATMN:PRD:4 The system will have network access. 

 
 
If you imported a PRD with these tags into RMTrak, RMTrak would, by default, trace all of the 
tags. But because you don’t want the RATMW and RATMN tags in the same project, you need a 
way to tell RMTrak that for one project you’d like to include the RATMN and RATM tags, and in 
another project you’d like to include the RATMW and RATM tags.  
 
RMTrak makes this easy to do with its tag filter. After creating two separate projects in RMTrak  
(one for RATMN and another for RATMW), you’d need to tell the tag filter of each project which 
tags it should recognize. 
 
In the RATMN project, you would add these tags to the tag filter: 
 

RATM:*  
RATMN:* 
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This tells RMTrak that the RATMN reports and views should only recognize tags within the 
imported documents if they begin with RATM: or RATMN: (and ignore all other tags). 
 
In the RATMW project, you would add these tags to the filter:  
 

RATM:*  
RATMW:* 

 
This tells RMTrak that the RATMW reports and views should only recognize tags within the 
imported documents if they begin with RATM: or RATMW: (and ignore all other tags). 
 
This will make sure that both projects include the general requirements, but don’t include the 
specific requirements of the other related project. 
 
 
Tag Filter Syntax 
 
To have the tag filter keep a tag or requirement from another database from being recognized in 
your current project, you can define the tag filter using the Tag Filter manager (available from the 
Setup menu in RMTrak). 
 
When you define a tag in the tag filter, use the first part of the tag, followed by its colon, followed 
by the rest of the appropriate part of the tag. If you want to use every kind of tag of that type, use 
an asterisk (*) to match zero or more characters.  
 
For example, to tell RMTrak only accept RATM tags for a project and to filter out any other kind, 
you'd type: 
 

RATM:* 
 
 
Defining the Tag Filter 
 

To define the tag filter, use the Tag Filter manager from the Setup menu.  

 
• To add a tag to the tag filter, type the tag in the first field provided while using correct tag 

filter syntax, then click New. 
 

• To remove a tag from the tag filter, find it in the list, click it, and then click Delete. 

 

  
Tag Filter Manager 
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The Tag Filter manager allows you to add and delete tags from the tag filter by either typing the 
tag in the first field provided or selecting it from the list, then clicking its corresponding button: 
 

New Adds a tag to the tag filter.  
 

� Note: The order in which you add the tags does not make any difference. 
 

Delete Deletes the tag from the tag filter.  

 

� Note: This button will not become available until you have selected a tag 
filter from the list. 
 

Done Closes the Tag Filter manager. 
 

Defining Options 
 
RMTrak lets you adjust the formatting/identification and requirements termination of tags, the 
document and revision numbering, and the output format of your project at any time.  
 
The initial settings are determined by how you originally created the database. You can change 
these default options at any time by using the Options manager, which is available from the 
Setup menu.  
 

 
Options Manager showing Tags tab 

 
 
The Options manager allows you to choose which options you want to have set up for your 
project, and overrides any initial options you set up when you originally created it.  
 
To select an option, click its name from the Options manager (available from the Setup menu in 
RMTrak). When you are finished, click OK. The Options manager has four tabbed sections: 
 

Tags Lets you choose tag identification as either red/bold text or a 
Microsoft® Word style.  
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Requirements Lets you choose requirement termination as either a hard 
return or a special character. 
 

Documents Lets you choose document and version numbering as being 
placed in the filename, the Microsoft® Word properties, or 
neither. 
 

Output Lets you choose to output reports in either HTML or 
Microsoft® Word format. 
 

These tabbed sections are further described below. 
 
 

Tags 
 
When you select the Tags tab, the Tags setup options appear. 

 

 
Tags setup options  

 
 

Red/Bold Text 
 
This option will set up RMTrak to recognize tags within your Documents as being any text 
that is both red and bold. 
 
 
Microsoft® Word Style 
 
This option will set up RMTrak to recognize tags within your Documents as being 
formatted in a specific Microsoft® Word style. (Microsoft® Word allows you to format text 
to have "styles," such as Body Text, Heading 1, Heading 2, and customized styles.) If you 
choose this option, a dialog box will appear. You'll need to type the name of the 
Microsoft® Word style exactly as it appears in Microsoft® Word. 

 
 

Requirements 
 
When you select the Requirements tab, the Requirements setup options appear. 



 RMTrak™ Requirements Management Tool User Manual © 2002 RBC Product Development http://www.RMTrak.com 42 

 

 
Requirements setup options  

 
 

Hard Carriage Return  
 
This option specifies that the tags in your documents will each end with a paragraph 
mark.  
 

i Tip: Paragraph marks (¶), which are created by pressing ENTER on the keyboard, are also called 

"hard carriage returns." Line breaks ( ), which are created by pressing SHIFT+ENTER, are also 
called "soft carriage returns." 

 
 
Special Character 
 
This option specifies that the tags in your document will each end with a specific 
character of your choice.  
 
If you choose this option, you will need to type in the space provided the character 
exactly as it will appear in your documents, or paste it from the clipboard.  
 
If you need help choosing a character, you can click the Char Map button to open the 
Character Picker (double-click a character to pick it). 
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Requirements setup options –  

Choosing a special character to terminate requirements 
 

 
 

Documents 
 
When you select the Documents tab, the Documents setup options appear. 

 

 
Documents setup options  

 
 

This tab has two sections: Document Number and Document Version. 
 
The Document Number section includes these options: 
 

None 
 
This option specifies that you will not track document numbers. 
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Contained in the filename  
 
This option specifies that you will place document numbers in the filename. If you want to 
specify document numbers in the filename, the format must be NNNNNNrevR.R.doc, 
where NNNNNN represents the document number, rev represents the abbreviation for 
"revision," R.R represents the revision number (which can be done in pointed increments 
or whole numbers), and .doc represents the Microsoft® Word file extension. 
 

� Note: The version and revision numbers can be any whole number or integer that does not contain 
spaces. For example, 3486rev3.4.1.doc and 112386rev21.4 are both valid file names.  
 

 
Contained in the document properties 
 
This option specifies that you will place document numbers in a customized property in 
Microsoft® Word's document Properties listings. If you choose this option, you will need 
to type in the space provided the custom name of the Microsoft® Word property exactly 
as it will appear in the Microsoft® document Properties listings for your documents.  
 

The Document Version section includes these options: 
 

None 
 
This option specifies that you will not track document revisions. 
 
 
Contained in the filename  
 
This option specifies that you will place document revisions in the filename. If you want to 
specify document revisions in the filename, the format must be NNNNNNrevR.R.doc, 
where NNNNNN represents the document number, rev represents the abbreviation for 
"revision," R.R represents the revision number (which can be done in pointed increments 
or whole numbers), and .doc represents the Microsoft® Word file extension. 
 

� Note: The version and revision numbers can be any whole number or integer that does not contain 
spaces. For example, 3486rev3.4.1.doc and 112386rev21.4 are both valid file names. 

 
 

Contained in the document properties  
 
This option specifies that you will place document revisions in a customized property in 
Microsoft® Word's document Properties listings. If you choose this option, you will need 
to type in the space provided the custom name of the Microsoft® Word property exactly 
as it will appear in the Microsoft® Word document Properties listings for your documents. 

 
 
 

Output 
 
When you select the Output tab, the Output setup options appear. 
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Output setup options  

 
 

HTML  
 
Selecting HTML will output reports in a Web page format. 
 
 
Microsoft® Word 
 
Selecting Microsoft® Word will output reports in Microsoft® Word documents. 

 

 

Changing Tag Identification 
 
By default, RMTrak recognize tags if they are formatted in red, bold text. You can change 
RMTrak’s project setup to instead recognize tags as any text formatted in a specific Microsoft® 
Word style.  
 

� Note: This change will affect all documents in the project. 
 
 

1. From the Setup menu, choose Options.  
 

2. Choose the Tags tab.  
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Tags setup options  

 
 

3. In the Requirements Termination setup, choose Microsoft® Word Style. 
A blank field will appear. 
 

4. In the blank field, type the name of the Microsoft® Word style you’ll be using. Be sure to 
spell it exactly as it appears in Microsoft® Word. For example, TagRequirement. 

 

i Tip: If you are unfamiliar with Microsoft® Word styles or how to create/edit one, see the Working with 
Microsoft Word topic. 
 
 

5. Click OK. 
RMTrak will return you to the Options window. 
 

6. Click OK to save your changes. 
 

 

Changing Requirements Terminators 
 
You can set up RMTrak to recognize a special character as the primary requirements terminator. 
This is especially helpful when you want to have multiple paragraphs or table cells in your 
requirements description. 
 

� Note: This change will affect all documents in the project. 
 

1. From the Setup menu, choose Options.  
 

2. Choose the Requirements tab.  
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Requirements setup options 

 
3. In the Requirements Termination setup, choose Special Character. 

 
4. Click Char Map. 

The Character Picker window will appear. 
 

5. Choose the character you want to end requirements descriptions with  
(for example, ~ ). 

 

 
Requirements setup options –  

Choosing a special character to terminate requirements 
 

6. Click OK. 
RMTrak will return you to the Options window. 
 

7. Click OK to save your changes. 
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Changing Number/Version Identification 
 
You can change how RMTrak recognizes a document’s number and/or version when you import 
documents: 
 

� Note: This change will affect all documents in the project. 
 

1. From the Setup menu, choose Options.  
 

2. Choose the Documents tab.  
 

 
Documents setup options  

 
 

3. In the Document Number section, choose how you want RMTrak to recognize document 
numbers. 
 

4. In the Document Version section, choose how you want RMTrak to recognize document 
versions. 
 

5. Click OK. 
RMTrak will return you to the Options window. 
 

6. Click OK to save your changes. 
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Changing Output Format 
 
You can set up RMTrak to output reports in either HTML (Web) or Microsoft® Word format. 
 

� Note: This change will affect all documents in the project. 
 
 

1. From the Setup menu, choose Options.  
 

2. Choose the Output tab.  
 

 
Output setup options  

 
 

3. Choose HTML or Microsoft® Word. 
 
4. Click OK. 

RMTrak will return you to the Options window. 
 

5. Click OK to save your changes. 
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Working with Documents 
 
The document types and analyses your company already uses to document project/product 
requirements can be directly imported into RMTrak as they're created. 
 
 
Tag Your Documents As You Create Them 
 
As you create documents for your project, simply place tags around each requirement. If you 
don't want the tags to interfere with your document's appearance or normal use, RMTrak allows 
you to apply a Microsoft® Word style to your tags. This allows you to format your documents to 
have a specific style, including invisibility.  
 

� Note: If you apply a Microsoft® Word style to your tags, make sure you have this option chosen in RMTrak's 
Document Setup. 

 
 
Import Each Document After You Create It 
 
It's important to import your requirements documentation as you create each document. This 
allows you to view the status of your project's requirements before proceeding with the next step 
of the project.  
 
When you import the document into RMTrak, RMTrak will recognize its tags and place the 
document's requirements in its database. You can then assign a document type to the document. 
This lets RMTrak knows the document's type and place in the hierarchy, and therefore how the 
documents relate to each other.  
 

� Note: For convenience, the list of document types already lists common product development document 
types—but you can add, delete, or edit these to match your company's needs. 
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Document Naming Conventions 
 
When you create or edit a document, you will need to save the file.  
 

• If you have configured RMTrak's Documents Setup to get the document number 
and/or revision from the filename, the document's filename must be formatted: 
 

NNNNNNrevR.R.doc 
 
where NNNNNN represents the document number, rev represents the abbreviation for 
"revision," R.R represents the revision/version number (which can be whole numbers or 
real numbers with up to two places to the right of the decimal), and .doc represents the 
Microsoft® Word file extension. 
 
For example, the filename 343rev2.1.doc would have the file number 343 and the version 
number 2.1.  

 

� Note: The version and revision numbers can be any whole number or integer that does not contain 
spaces. For example, 3486rev3.4.1.doc and 112386rev21.4 are both valid file names.  
 

 
• If you have configured RMTrak to not recognize document numbers or revisions, or 

have configured RMTrak to get the document number and revision from RMTrak's 
Documents Setup, you can name the document any acceptable Microsoft® Word 
filename.  
 

� Note: The naming convention you use must be maintained for all documents within a project. You 
should also consider naming all of the documents in your organization (that will be used in RMTrak 
projects) with the same format; this will eliminate confusion and save time.  

 

Creating Documents 
 
You need not create documents specifically for RMTrak; rather, your company can continue to 
create the project/product requirements documents you always have, with these changes: 
 

• Create the documents in Microsoft® Word. 
 

• Place tags around each requirement in the documents. (These tags can be made 
invisible by applying a Microsoft® Word style to them.) 
 

• Configure RMTrak's setup options to match how you create your documents. These 
setup options include how you'll tag, where you'll keep document numbers and revisions, 
the types of attributes you'll use, the document types you'll import, and more. 
 

• Give the documents filenames that use the appropriate document naming conventions, 
depending on how you configured RMTrak's setup options. 
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Rather than giving you many restrictions, RMTrak lets you set your own restrictions. You need 
only configure RMTrak to recognize your documents. For this reason, creating documents has 
two steps, which can be performed in reverse order if preferred: 
 

1. Create a new RMTrak database for your project with setup options matching how you 
create your documents.  
 
�   Note: You can change these options after you've created the database by using the Setup menu.  
 

2. Create documents that match RMTrak's setup options. 
 

 
You can open the sample documents installed with RMTrak to see examples of RMTrak 
documents. 
 

Incrementing Document Versions 
 
If you change the content of your documents, including its requirements, you should save it as a 
new, incremented version. This will distinguish it from previous versions and help you track 
changes made to documents over time. For example, if your product development team reviewed 
a document and determined it needed changes, you could re-save the document to a new name 
and archive the old document. RMTrak cannot do this for you; you will need to do this manually 
using Microsoft® Word.  
 
 
Increment Document Number and Saving New File 
 
If you change the contents of a document, you should save it to a new name that reflects its 
version. If you have configured RMTrak's Documents Setup to recognize document numbers in 
the file name, be sure to follow document naming conventions for every file.  
 
For example, if you make changes to the file:  
 

343rev1.doc 
 

You should save the file to the name: 
 

343rev2.doc  
 
This will show the file is now in its second version. (If you're using the partial increments, you can 
use 343rev1.1.doc instead of 343rev2.doc).  
 
You can then archive the 343rev1.doc file and change the document in RMTrak: 
 
 
Update Document Version In RMTrak 
 
When you increment document versions (for example, from version 1.2 to 1.3), RMTrak will 
automatically recognize the new version and update its database with the new information—
provided the new file is kept in the same folder location as the previous version, and provided you 
have set up RMTrak to recognize document numbers and revisions. 
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� Note: If you've incremented your document to another version and you have RMTrak set up not to recognize 
document numbers and revisions or keep the file in a new location, you'll need to manually modify its 
properties and/or change its file location. 

 
Additionally, if you have configured RMTrak's Document Types manager to recognize file names, 
RMTrak will recognize if a document's version was inversely incremented (for example, 
343rev3.doc added after 343rev6.doc) and notify you. 
 

If you have made changes to a requirement, RMTrak will mark its child requirements as suspect. 
This lets you create a Suspect report to quickly find out which requirements might also need to be 
changed.  
 

Opening Documents 
 
To open a document in your project's RMTrak database, highlight the document in the 
Documents manager then click the Open.  
 

� Note: To modify the document, you'll need to first make sure it’s not open within RMTrak. Remember that if 
you make any modifications to the document, you'll need to refresh it in the RMTrak database. 

 
 

Putting Document Information In Filenames 
 
RMTrak can import the number and version of a document from your document's filename, 
provided you: 
 

• Choose Contained in the filename from RMTrak's Documents Setup  
• Use the correct document naming conventions for your filename 

 

� Note: If desired, you can place document information in the document's properties instead of its filename. 
 
 

 
Configure RMTrak's Documents Setup 
 
To adjust RMTrak's Documents Setup: 
 

1. From the Setup menu, choose Options.  
 

2. Select the Documents tab.  
 

3. In the Document Number and/or Document Version section(s), choose Contained in 
the filename.  
 

4. Click OK when you're finished. 
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Documents setup options 

 
 
For more information about setting RMTrak's documents setup options, please see the Changing 
Project Setup topic. 
 
 
 
Getting RMTrak to Recognize the Document Information In Filename 
 
RMTrak will recognize the document information you've placed in the filename whenever you: 
 

• Import the document 
• Edit the document's properties 
• Refresh the document 

 

Putting Document Information In Properties 
 
RMTrak can import the number and version of a document from your document's customized 
document properties, provided you: 
 

• Choose Contained in the document property from RMTrak's Documents Setup and 
type the document property name exactly as it appears in your documents 
 

• Add the custom document properties to your documents. 
 

� Note: If desired, you can place document information in the document's filename instead of its document 
properties. 
 

 
Configure RMTrak's Documents Setup 
 
To adjust RMTrak's Documents Setup: 
 

1. From the Setup menu, choose Options.  
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2. Select the Documents tab.  
 

3. In the Document Number and/or Document Version section(s), choose Contained in 
the document property.  
 

4. Click OK when you're finished. 
 

 
Documents setup options 

 
 
Adding Custom Document Properties to Your Documents 
 
You can add custom document properties to your documents by using the Custom tab: 
 

1. In Microsoft® Word, from the File menu, choose Properties. 
 

2. Click Custom.  
 

3. Add the custom properties you desire (for example, Number or Version) by typing each 
the appropriate information in each field then clicking Add. 
 

Name The name of the custom property you are creating. For example, Docnum or 
Docrev (for "document number" and "document revision"). 

 
�  Note: Remember that it doesn't matter what you call the custom property as long as its 

spelling exactly matches what you provide in RMTrak's Documents setup options. 
 

Type The type of custom property you are creating. (RMTrak recommends Text). 
 

Value The value of the custom property you are creating. For example, 1.2. 
 

4. When you're finished, click OK. 
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Custom Properties for RATM Product Requirements.doc sample file 

 
 

� Note: If you need additional help creating custom properties, please consult Microsoft® Word Help. 
 

In the example above, the custom properties are called Docnum and Docrev, but you can name 
your custom properties anything you like, as long as you've configured RMTrak's Document 
Setup with matching property names. Remember that document versions can be whole numbers 
(1, 2, 3, etc.) or real numbers with up to two places to the right of the decimal (1.35, 2.63, 9.65, etc.). 
 
 
 
Getting RMTrak to Recognize the Document Information In Document Properties 
 
RMTrak will recognize the document information you've placed in the document properties 
whenever you: 
 

• Import the document 
• Edit the document's properties 
• Refresh the document 

 

Working with Microsoft® Word 
 
If you are not familiar with the functionality and options of the Microsoft® Word program, RBC 
Product Development recommends you take some time to look at the help files and tutorials the 
program provides. The documents in the sample RMTrak database show some of the formatting 
options available. Using program options like auto text, auto-generated table of contents, headers 
and footers, etc., can increase efficiency and clarity in your documents and save you time. 
Additionally, RMTrak installs macros that can help you with your requirements management 
documents. Because RMTrak is designed to work with Microsoft® Word, the more you are able to 
get from Microsoft® Word, the better your requirements management process will be.  
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Formatting Text To Be Bold and Red 
 
One option for formatting text is to format your tags to be bold and red, in Microsoft® Word, 
highlight the tag then: 

 
1. From the Format menu, choose Font. 

 
2. From the Font style list, choose Bold. 

 
3. From the Font color list, choose Red.  
 

�  Note: If you're not sure which color is red, place your mouse over each color without clicking, and its 
name will pop up. Choose the color that says "Red." 
 

4. Click OK. 
 

 
Creating and Applying Microsoft® Word Styles 
 
To format your tags to be a Microsoft® Word style, you'll first need to create a new style: 

 
1. From the Format menu, choose Style 

The Style window will appear. 
 

 
Style window 

 
 

2. Click New. 
 

3. Type the name of the style exactly as you have (or will) type it in the Tags Setup for 
RMTrak (for example, RMTrak Tags). 
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4. To assign its font properties, click Format then choose Font. 
Assign font properties you want to give to the tags. If you want the tags to be 
invisible, select the Hidden check box in the Effects section. When you are finished, 
click OK. 
 

5. To assign its paragraph properties, click Format then choose Paragraph. Assign 
paragraph properties you want to give the tags.  
 

6. When you are finished, click OK. 
 

7. Click Close.  
The style will appear in the Style drop-down list (to the left of the Font drop-down 
list). 

 
You can also use the TagConvert macro. 
 
Once you've created a style, you can apply it to your tag at any time by highlighting the tag, 
then selecting the style from the Style drop-down list. (This list usually appears to the left of 
the Font drop-down list.) 
 

 
 
Turning Hidden Text Off and On 
 
If you create a Microsoft® Word style that is invisible (or have merely formatted paragraph 
text to be invisible, you can enable or disable your ability to see the hidden text at any time: In 
Microsoft® Word: 

 
1. From the Tools menu, choose Options.  

 
2. Click the View tab.  

 
3. In the Formatting Marks section, check or uncheck the Hidden Text check box.  

 
4. Click OK. 

 
 

 
Paragraph Marks 
 
You can create a paragraph mark (¶), also called a "hard carriage return," by pressing 
ENTER on your keyboard.  
 
You can create a line break ( ), also called a "soft carriage return" by pressing SHIFT + 
ENTER on your keyboard. If your document uses a hard carriage return as a tag terminator, 
you'll need to use line breaks frequently within tags and requirements.  
 
To see paragraph marks, you'll need to make sure Microsoft® Word has the paragraph marks 
option turned on: 
 
 
Turning Paragraph Marks Off and On 
 
If you use paragraph marks (¶) as tag terminators in your document, you'll need to make sure 
you can see them:  
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1. In Microsoft® Word, from the Tools menu, choose Options.  

 
2. Click the View tab.  

 
3. In the Formatting Marks section, check the Paragraph marks check box.  

 
4. Click OK.  

 
 

Paragraph marks will look like ¶; line breaks will look like , and spaces will appear as a 
single dot. 
 
 
Creating Custom Document Properties 
 
You can add custom document properties. For detailed instructions, see the Putting 
Document Information In Document Properties topic. 

 
 

Macros and Tag Menu 
 
When you install RMTrak, you can also install a Tag.dot template. The purpose of this template is 
to create a Tag Menu and macros you can access and use from any Microsoft® Word document. 
To remove the Tag Menu and macros, you'll need to remove the Tag.dot file from your 
Microsoft® Word Startup directory. 
 
Macros that install with RMTrak: 
 

Tag2Text Converts selected text to non-red/non-bold text. 
 

Text2Tag Converts selected text to red/bold text. 
 

TagIndex Puts a tag index at the cursor location. If a tag index already 
exists in the document, Microsoft® Word asks if you want to 
delete it. 
 

TagMatrix Puts a tag matrix at the cursor location. If a tag matrix already 
exists in the document, Microsoft® Word asks if you want to 
delete it. 
 

TagInsert Displays a dialog box and then inserts a tag at the cursor 
location. 
 

TagRenumber Renumbers all of the tags in a document so that they are 
sequential. 
 

TagAbout Displays a dialog box list information about the tag macros. 
 

TagConvert Converts red/bold text to a Microsoft® Word style. 
 

 
 



 RMTrak™ Requirements Management Tool User Manual © 2002 RBC Product Development http://www.RMTrak.com 60 

To use these macros: 
 

1. In Microsoft® Word, from the Tools menu, choose Macro, then Macros.  
(A shortcut for these steps is to press ALT+F8).  
The Macros window will appear.  
 

2. Choose a macro from the list then click Run. 
 

You can assign shortcuts to macros using this procedure: 
 

1. In Microsoft® Word, from the Tools menu, choose Macro, then Record New Macro. 
 

2. Use the Record Macro window to record the chosen macro. If you need help doing this, 
please consult Microsoft® Word Help. 

 
 
Macros will only work with tags that use RMTrak’s recommended tag format:  
 

[Project Title or Acronym]:[Document Title or Acronym]:[Tag Number] 
 
For example:  
 

RATM:PVTR:1 
 
Tag Menu 
 
RMTrak also installs a Tag Menu you can access from any Microsoft® Word document. The Tag 
Menu is available in Microsoft® Word’s menu bar under the word Tags. 
 

 
Tag Menu 

 
The Tag Menu provides shortcuts to a few of the macros RMTrak installs, including: 
 

Tag Menu 
Option 
 

Corresponding 
Macro 

Explanation 
 

Insert Tag TagInsert Displays a dialog box and then inserts a tag at the 
cursor location. 
 

Insert 
Matrix 

TagMatrix Puts a tag matrix at the cursor location. If a tag 
matrix already exists in the document, Microsoft® 
Word asks if you want to delete it. 
 

Insert Index TagIndex Puts a tag index at the cursor location. If a tag 
index already exists in the document, Microsoft® 
Word asks if you want to delete it. 
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Renumber TagRenumber Renumbers all of the tags in a document so that 

they are sequential. 
 

About TagAbout Displays a dialog box list information about the tag 
macros. 
 

 

 

Terminal Requirements and Documents 
 
Terminal requirements, not to be confused with Tag Termination, are requirements that do not 
have any children requirements; these requirements usually give the requirement's status, 
including whether it has passed its tests, and are typically listed only in terminal documents. 
Terminal documents are documents that list terminal requirements and which do not have any 
children documents. 
 
 
Terminal Documents 
 
A "terminal document" is a document whose document type has been marked Terminal in the 
Document Types manager. Terminal documents do not have any children documents and usually 
include test results. 
 
For example, in the following documents and their tags, the dark blue documents would be 
considered terminal documents because no other documents follow them. 
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Terminal documents are usually test-type documents where the document's purpose is, among 
other things, to provide a checklist of requirements' progress and status.  
 
 
Make a Document Terminal 
 
Designating a document as terminal allows RMTrak to recognize the document's relationship to 
other documents. You should designate a document as Terminal if the document has no children 
documents.  
 
To tell RMTrak a document is terminal: 
 

1. Apply a document type to the document using the Add Document dialog or the Modify 
Documents dialog. 
 

2. Edit the document type in the Document Types manager so it is Terminal. 
 
 
 
Childless Requirements  
 
Terminal requirements will also be childless requirements; however, RMTrak will not include 
these requirements in a Childless Report, which is intended to show requirements that should 
have requirements tracing back to them. 
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RMTrak recognizes tags through their syntax and their formatting, which can be either bold and 
red, or a specific Microsoft® Word style. 
 
 
Tags Setup 
 
The method RMTrak uses to identify tags depends on how you've set up its Tags Setup. This 
setup is available from RMTrak’s Setup menu by choosing the Tags tab. 
 
When you select the Tags tab, the Tags setup options appear. 
 

 
Tags setup options 

 
The Tags Setup section has these two options: 
 

Red/Bold 
Text 

If RMTrak is set up with this option, RMTrak will recognize tags 
within your documents as being any text that is both red and bold.  
 

Microsoft® 
Word Style 

If RMTrak is set up with this option, RMTrak will recognize tags 
within your documents as being any text that is formatted in a 
specific Microsoft® Word style. If you choose Microsoft® Word 
Style, a dialog box will appear. You'll need to type the name of 
the Microsoft® Word style exactly as it appears in your 
documents. 

 
For more information on how RMTrak recognizes requirements, see the Requirement 
Identification topic. 
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When you import documents into RMTrak, RMTrak recognizes the documents’ requirements by 
the tags you put around each requirement. Tags can consist of any unique, memorable set of 
letters or numbers you create. We recommend you organize your tags consistently by placing the 
project acronym at the start of each tag, then the document name’s acronym, and then the 
requirement’s number, all separated by colons. 
 
For example, a requirement using RMTrak’s default settings could look like:  
 

RATM:SHA:1 Circuit shall be designed to minimize impact of faulty ground. ¶ 
 

i Tip: This example is the Number 1 Requirement listed in the Revolutionary Automated Teller Machine (RATM) 
project’s System Hazards Analysis (SHA) document. The number of the tag (1) is an arbitrary number and 
doesn’t have significance other than being a unique identifier for the requirement. The final paragraph mark 
(¶) is a requirements terminator that lets RMTrak know you have finished writing about that requirement. 

 
The method RMTrak uses to identify requirements depends on the requirement's termination. 
 
For more information on how RMTrak recognizes requirements, see the Tag Identification topic. 
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"Tag termination" refers to RMTrak's ability to determine the end of a tag/requirement so it can go 
on to look for another one in the document.  
 
RMTrak recognizes the end of requirements when it encounters: 
 

• A requirements terminator. Requirements terminators can be the end of a paragraph (¶) 
or a character you specify in RMTrak’s project settings 

• The start of a new tag—if it’s not in brackets ( [ ] ) 

• The end of the document 
 
If RMTrak cannot find a requirement terminator, or if there appears to be multiple or conflicting 
tags, RMTrak will automatically recognize the next bold, red RATM tag, if it is not in brackets  
( [ ] ), to be the start of a new requirement.  
 

i Tip: You can configure RMTrak to recognize requirements in a specified Microsoft® Word style instead of bold, 
red formatting. You can also configure RMTrak to recognize any special symbol or character instead of a 
paragraph mark (¶). To do this, from RMTrak’s Setup menu, choose Options. 

 
 
Requirements Termination Setup 
 
The method RMTrak uses to identify tags' termination depends on how you've set up its 
Requirements Setup. When you select the Requirements tab, the Requirements setup options 
appear. 
 

 
Requirements setup options 
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The Requirements Setup section has these two options for determining tag termination: 
 

Hard 
Carriage 
Return 

If RMTrak is set up with this option, RMTrak will recognize a tag's 
termination as being a paragraph mark (¶).  

 
i  Tip: Paragraph marks (¶), which are created by pressing ENTER on the 

keyboard, are also called "hard carriage returns." Line breaks ( ), 
which are created by pressing SHIFT+ENTER, are also called "soft 
carriage returns." 
 

Special 
Character 

If RMTrak is set up with this option, RMTrak will recognize a tag's 
termination as being specific character of your choice.  
 
If you choose this option, a field appears. You will need to type in 
this field the character exactly as it will appear in your documents, 
or paste it from the clipboard.  
 
If you need help choosing a character, you can click the Char 
Map button to open the Character Picker (double-click a character 
to pick it). 
 

 

 
Requirements setup options –  

Choosing a special character to terminate requirements 
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Overview of Tagging 
 
RMTrak works with your current documentation (created in Microsoft® Word) with one 
adjustment: adding tags around each requirement. Additionally, you can place attributes around 
requirements.  
 
Tags and tagged attributes allow RMTrak to recognize your document’s requirements so you can 
generate reports and views to trace their relationships and status. 
 
To add tags to your document: 

 
1. Create a document and use it to document your project’s requirements. 

 
2. As you discuss each requirement, place tags around each requirement. You can use the 

Tag menu that RMTrak installs into Microsoft® Word to help you.  
 
See the Syntax and Structure topic for help on how to write tags, attributes, parent tags, 
and terminators. 

 
 

Syntax and Structure 
 
The tags you place around the requirements in your document will need to be structured so 
RMTrak can recognize your requirements.  
 
The structure of a tagged requirement is: 
 

Initial Tag Requirement Description {Attribute} [Parent Tag] Terminator 
 
An example of a requirement using correct syntax: 

RATM:PVTR:1 The circuit shall be interrupted when the ground is shorted. 
{Test Method = I} [RATM:PRD:1] ¶ 

 
The structure of the initial tag, requirement text, attribute(s), parent tag(s), and terminator can be 
arranged in any order—so long as the requirement begins with the initial tag. 
 

Each part of the structure is described below:  
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Initial Tag Syntax 
 
Each requirement in each document will need a unique, initial tag. Each requirement’s initial 
tag must be placed at the beginning of the requirement.  
 
We recommend you organize your tags consistently by placing the project acronym at the 
start of each tag, then the document name’s acronym, and then the requirement’s number, all 
separated by colons. Syntax should be consistent for every document. The initial tag may not 
contain any spaces. 
 

[Project Title or Acronym]:[Document Title or Acronym]:[Tag Number] 
 

Example: 
 
RATM:SHA:2 Circuit shall be designed to minimize impact of faulty ground. 
 

i Tip: The above example is the Number 2 Requirement listed in the Revolutionary Automated Teller 
Machine (RATM) project’s System Hazards Analysis (SHA) document. The number of the tag (2) is an 
arbitrary number and doesn’t have significance other than being a unique identifier for the requirement.  

 
 

Requirements Description Syntax 
 
Project requirements are any description and can be in any format or style. You can also 
place them in tables or multiple paragraphs.  
 
Example: The circuit shall be interrupted when the ground is shorted. 
 
 
Attribute Syntax 
 
The syntax for an attribute is an opening curly bracket, the name of the attribute including any 
spaces, an equals sign, the value of the attribute, and then a closing curly bracket. Attributes 
may contain spaces. 
 
Example: {Test Method = I} 
 
Attributes are optional and might not be present in the project's first document. They’re 
intended for status updates or to add further information to a requirement. RMTrak’s default 
attributes use acronyms. 
 

� Note: Attributes are set up in RMTrak’s project settings. For RMTrak to recognize these attributes and 
track/trace them in views and reports, the project will need to be configured in RMTrak to include a Test 
Method attribute, a Test Pass attribute (with T and F as possible attributes), a Tester attribute, and a 
Test Date attribute. To edit attributes in RMTrak, from the Setup menu, choose Attributes. 
 

You can add multiple attributes to a project. RMTrak will recognize attributes, regardless of 
their placement, as long as they occur before the start of a new requirement.  
 
You can list attributes separately or within the same curly brackets, separated by commas. 
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Example of attributes listed separately: 
 
RATM:PVTR:1 The circuit shall be interrupted when the ground is shorted.  

{Test Status = P} {Test Date = 11/01/01} {Test Method = D} {Tester = 
QA} [RATM:PRD:1]¶ 
 

Example of attributes listed together:  
 
RATM:PVTR:1 The circuit shall be interrupted when the ground is shorted. 

{Test Status = P, Test Date = 11/01/01, Test Method = D, Tester = QA} 
[RATM:PRD:1]¶ 
 

 
Parent Tag Syntax 
 
Parent tags are similar to regular tags, but show which previous requirement led to this one. 
Parent tags are placed in brackets ( [ ] ). 
 
Example: [RATM:PRD:1] 
 
Parent tags won't be present in the project's first document. This example tag shows that this 
requirement originated from the first requirement of the Product Requirements Document 
(PRD).  
 
You can add multiple attributes to a project. RMTrak will recognize attributes, regardless of 
their placement, as long as they occur before the start of a new requirement.  

 
Example: 
 
RATM:PVTR:1 The circuit shall be interrupted when the ground is shorted. 

{Test Status = P} {Test Date = 11/01/01} {Test Method = D} {Tester = 
QA} [RATM:PRD:1]¶ 
 

 
Terminator Syntax 
 
A terminator can be a paragraph mark (¶) or a symbol of your choice, provided you configure 
the symbol in RMTrak’s project setup.  
 
The format of the terminator can be red and bold or be a Microsoft® Word style, provided you 
configure the style in RMTrak's project setup.  

 

i Tip: Paragraph marks (¶), which are created by pressing ENTER on the keyboard, are also called "hard 

carriage returns." Line breaks ( ), which are created by pressing SHIFT+ENTER, are also called "soft 
carriage returns." 
 

 
If RMTrak cannot find a requirement terminator, or if there appears to be multiple or 
conflicting tags, RMTrak will automatically recognize the next bold, red RATM tag, if it is not 
in brackets ( [ ] ), to be the start of a new requirement.  

 

i Tip: You can configure RMTrak to recognize requirements in a specified Microsoft® Word style instead of 
bold, red formatting. You can also configure RMTrak to recognize any special symbol or character 
instead of a paragraph mark (¶). To do this, from RMTrak’s Setup menu, choose Options. 
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Attributes 
 
Attributes are used to specify information about a requirement. By adding attributes to your tags, 
you can trace requirements' information, such as implementors, test dates, and test status, within 
RMTrak. RMTrak recognizes a requirement's attributes by the attribute tags placed around it in 
curly brackets.  
 
For example, a requirement with attributes using RMTrak’s default settings might look like: 
 

RATM:VTP:1 The circuit shall be interrupted when the ground is shorted. 
{Test Method = I} {Test Pass = T} {Tester = QA} {Test Date = 5/17/00} 
[RATM:PRD:1] ¶ 

 

 
In the above example, items provided in the curly brackets are tagged attributes. They show: 
 

• The requirement was tested using the Inspection (I) test method. 
• It is true (T) that the requirement passed its tests. 
• The requirement was tested by the Quality Assurance (QA) department. 
• The requirement was tested on 5/17/00. 

 

� Note: Attributes are set up in RMTrak’s project settings. For RMTrak to recognize these attributes and 
track/trace them in views and reports, the project will need to be configured in RMTrak to include a Test 
Method attribute (with I as one possible value), a Test Pass attribute (with T and F as possible attributes), a 
Tester attribute (with QA as one possible value), and a Test Date attribute. To edit attributes in RMTrak, from 
the Setup menu, choose Attributes. 

 
The presence of an attribute in a tag is optional. Additionally, tags might not be present in the 
project's first document. Attributes are intended for status updates or to add further information to 
a requirement.  
 
 
Persistent Attributes 
 
In the Attributes manager, which is available from the Setup menu, you can designate an 
attribute as Persistent. If the Persistent check box is checked for an attribute, the attribute's 
values can be assigned to requirements from within RMTrak's Allocation view. This would 
eliminate the need to specify the attribute in your documents' tags.  

 

 Warning: If you use Persistent attributes, you might want to periodically save your database to a 
different name (leaving the previous named version as a "backup" copy). Otherwise, should you lose 
the database, the information you stored in it would also be lost. If you want to retain RMTrak's 
document-centric benefit of leaving important information in the documents rather than in the 
database, do not use persistent attributes. 
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Tags Across Multiple Paragraphs 
 
RMTrak has an efficient way of handling requirements that are spread across multiple 
paragraphs: If you place part of a requirement’s text in one paragraph, but place its attribute tags 
in another paragraph, RMTrak will still recognize the attributes that accompany the requirement. 
 
For example, you could have a Verification Testing Process (VTP) document with the following 
requirement. 
 

Example: 
 

Test Procedures and Results for RATM:VTP:1  ¶ 
The circuit shall be interrupted when the ground  
is shorted. {Test Method = I} {Tester = QA} [RATM:PRD:1] ¶ 
Expected Result: GFI is used and trips when the  
ground is interrupted. ¶ 
Actual Result: Expected results were observed. ¶ 
Test Procedures: . . . (several paragraphs) ¶ 
{Test Pass = T} {Test Date = 5/17/00} ¶ 
 

Test Procedures and Results for RATM:VTP:2 
Inspection of the RATM unit shall show the use of a  
waterproof seal. {Test Method = I} {Tester = HW} [RATM:PRD:2] ¶ 
Expected Result: Watertight box is used. ¶ 
Actual Result: Expected results were observed. ¶ 
Test Procedures: . . . (several paragraphs) ¶ 
{Test Pass = T} {Test Date = 5/17/00} ¶ 
 

 
RMTrak would completely ignore the paragraphs after the first paragraph symbol (¶), but would 
still recognize the final attribute tags, resulting in RMTrak recognizing following requirements.  
 

RATM:VTP:1 The circuit shall be interrupted when the ground is 
shorted. {Test Method = I} {Test Pass = T} {Tester = QA} {Test 
Date = 5/17/00} [RATM:PRD:1] ¶ 

 
RATM:VTP:2 Inspection of the RATM unit shall show the use of a 

water proof seal. {Test Method = I} {Tester = HW} [RATM:PRD:2] 
{Test Pass = T} {Test Date = 5/17/00} ¶ 
 

 

i Tip: The paragraph symbol (¶) can be created by pressing ENTER on your keyboard. To see the paragraph 
symbol, you need to change Microsoft® Word’s settings to see hidden text: From the Tools menu, choose 
Options, choose the View tab, and then check the Paragraph Marks check box. Click OK. 
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Requirements Descriptions Across Multiple 
Paragraphs  
 
A complication occurs if you try to place requirements description within separate paragraphs but 
you don’t want RMTrak to ignore the text that’s in the separate paragraphs. 
 
To do this, you’d need to change RMTrak to no longer recognize paragraph marks as the end to 
requirements descriptions. You can do this by setting up RMTrak to recognize a special character 
as the primary requirements terminator. 
 
You can then use the special character to let RMTrak know where requirements description ends.  
 

Example: 
 

Test Procedures and Results for RATM:VTP:1 ¶ 
The circuit shall be interrupted when the ground is  
shorted. {Test Method = I} {Tester = QA} [RATM:PRD:1] ¶ 

Expected Result: GFI is used and trips when the ground is interrupted. ~ 
Actual Result: Expected results were observed. ¶ 
Test Procedures: . . . (several paragraphs) ¶ 
{Test Pass = T} {Test Date = 5/17/00} ¶ 
 

Test Procedures and Results for RATM:VTP:2 ¶ 
Inspection of the RATM unit shall show the use of a water  
proof seal. {Test Method = I} {Tester = HW} [RATM:PRD:2] ¶ 

Expected Result: Watertight box is used. ~ 
Actual Result: Expected results were observed. ¶ 
Test Procedures: . . . (several paragraphs) ¶ 
{Test Pass = T} {Test Date = 5/17/00} ¶ 

 
� Note: The special character (here, the ~) tells RMTrak where to end requirements descriptions for the 

requirements. 
 

From the above example, RMTrak would recognize these requirements: 
 

RATM:VTP:1 The circuit shall be interrupted when the ground is  
shorted. GFI is used and trips when the ground is  
interrupted. {Test Method = I} {Test Pass = T} {Tester =  
QA} {Test Date = 5/17/00} [RATM:PRD:1] ¶ 

 
RATM:VTP:9 Inspection of the RATM unit shall show the use of a  

water proof seal. Watertight box is used. {Test Method = I}  
{Tester = HW} {Test Pass = T} {Test Date = 5/17/00}  
[RATM:PRD:2] ¶ 

 
 
RMTrak would recognize the additional text occurring before the special symbol you chose (~ ), 
and would ignore any text occurring after it, but would still recognize the attributes at the end of 
the row. 
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Mixing Requirements Terminators In Paragraphs 
 
Because RMTrak recognizes the end of a requirement when it encounters a new one or when it 
reaches the end of a document, it’s easy to mix requirements terminators. This can be beneficial 
if you have requirements in which you want to use the paragraph tag (or special character) as 
requirement terminator but some occurrences in which you do not. 
 
For example, if the ~ symbol were left out for RATM:VTP:9 (as shown below), RMTrak would still 
recognize its first paragraph (to the first paragraph mark) as being its requirements description. 
This is because it’s followed by a new requirement (RATM:VTP:10): 
 

Example: 
 
1. Test Setup: RATM:VTP:1 The circuit shall be interrupted  

when the ground is shorted. {Test Method = I} {Tester = QA}  
[RATM:PRD:1]  
Expected Result: GFI is used and trips when the ground is  

interrupted. ~   
Actual Result:  Expected results were observed.   
Pass/Fail: {Test Pass = T} {Test Date = 5/17/00}  
 

 
2. Test Setup: RATM:VTP:9 Inspection of the RATM unit shall  

show the use of a water proof seal. {Test Method = I}  
{Tester = HW} [RATM:PRD:2]  
Expected Result: Watertight box is used.  
Actual Result:  Expected results were observed  
Pass/Fail: {Test Pass = T} {Test Date = 5/17/00}  
 

 
3. Test Setup: RATM:VTP:10 Unit shall be tested with  

Multimeter to verify the fuses are in series and of the  
rated value.   
{Test Method = T} {Tester = QA} [RATM:PRD:5]  
Expected Result: Circuit will be open when fuses are not  

present and closed when fuses present. ~ 
Actual Result:  Expected results were observed   
Pass/Fail: {Test Pass = T} {Test Date = 5/17/00}   

 

� Note: The special character (here, ~) tells RMTrak where to end the requirements descriptions for 
RATM:VTP:1 and RATM:VTP:10 but not RATM:VTP:9. This leaves RMTrak to interpret RATM:VTP:9’s 
requirement description by first recognizing the beginning of RATM:VTP:10, and then backtracking to collect 
RATM:VTP:9’s first paragraph. 
 
 

From the above example, RMTrak would recognize these requirements: 
 

RATM:VTP:1 The circuit shall be interrupted when the ground is  
shorted. GFI is used and trips when the ground is  
interrupted. {Test Method = I} {Test Pass = T} {Tester =  
QA} {Test Date = 5/17/00} [RATM:PRD:1] ¶ 

 
RATM:VTP:9 Inspection of the RATM unit shall show the use of a  

water proof seal. {Test Method = I} {Tester = HW} {Test  
Pass = T} {Test Date = 5/17/00} [RATM:PRD:2] ¶ 

 
RATM:VTP:10 Unit shall be tested with Multimeter to verify the  
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fuses are in series and of the rated value. Circuit will be  
open when fuses are not present and closed when fuses  
present. {Test Method = T} {Tester = QA} {Test Pass = T}  
{Test Date = 5/17/00} [RATM:PRD:5] ¶ 
 

 
Notice that the text for RATM:VTP:1 and RATM:VTP:10 both include the text from the second 
column, but RATM:VTP:9 does not.  
 
Similarly, if the ~ symbol were left out for RATM:VTP:10, RMTrak would still recognize its 
requirements description because the requirement was followed by the end of the document. 
 

 

Tagging In Tables 

Tags In Individual Table Cells 

 
RMTrak sees table cell borders as paragraph marks. This means that RMTrak treats 
requirements in individual table cells as separate paragraphs. This makes most tagging in tables 
simple and easy.  
 
For example, you could have a Systems Hazard Analysis (SHA) document with requirements that 
were each placed in individual table cells and RMTrak would easily recognize these 
requirements. 
 

Example: 
 

# Potential 
Hazard 
 

Potential 
Cause 

Mitigation (safety 
requirement) 

Responsibility 

1 User gets 
shocked. 

Faulty 
ground in 
circuit 

RATM:SHA:1 Circuit 
shall be designed to 
minimize impact of 
faulty ground. 
 

Hardware 

2 User gets 
shocked. 

Water got 
inside the 
box. 

RATM:SHA:2 System 
shall prevent 
moisture from 
entering the 
environment.  
  

Mechanical 

3 User gets 
shocked. 

Membrane 
panel is 
damaged. 

RATM:SHA:3 Damage to 
the unit shall be 
detected by regular 
inspection.  
 

Labeling 

 

From the above example, RMTrak would recognize these requirements: 
 

RATM:SHA:1 Circuit shall be designed to minimize impact of faulty ground. 
RATM:SHA:2 System shall prevent moisture from entering the environment.  
RATM:SHA:3 Damage to the unit shall be detected by regular inspection.  
RATM:SHA:4 System shall allow for maintenance without risk of electrical 

shock.  
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� Note: Requirements shown here are initial requirements and do not have parent requirements. 

 

Tags Across Multiple Table Cells  

 
If you place part of a requirement’s text in one cell, but place its attribute tags in another or cell, 
RMTrak will still recognize the attributes that accompany the requirement. 
 
For example, you could place some or all of the attribute tags in separate cells and RMTrak 
would still recognize the attributes, regardless of any other cells between them.  
 

Example: 
 

Test Setup Expected 
Result 

Actual 
Result 

Pass/Fail 
 

RATM:VTP:1 The 
circuit shall be 
interrupted when the 
ground is shorted.  
{Test Method = I}  
{Tester = QA} 
[RATM:PRD:1] 
 

GFI is used 
and trips 
when the 
ground is 
interrupted. 

Expected 
results were 
observed.   

{Test Pass = T} 
{Test Date = 
5/17/00} 

RATM:VTP:9 Inspection 
of the RATM unit 
shall show the use of 
a water proof seal.  
{Test Method = I}  
{Tester = HW} 
[RATM:PRD:2] 
 

Watertight 
box is used. 

Expected 
results were 
observed 

{Test Pass = T} 
{Test Date = 
5/17/00} 

RATM:VTP:10 Unit 
shall be tested with 
Multimeter to verify 
the fuses are in 
series and of the 
rated value.   
{Test Method = T}  
{Tester = QA} 
[RATM:PRD:5] 

Circuit will 
be open when 
fuses are not 
present and 
closed when 
fuses 
present. 

Expected 
results were 
observed 

{Test Pass = T} 
{Test Date = 
5/17/00} 

 
RMTrak would completely ignore the text after the first cell border but would still recognize the 
attributes in the last column as being part of the requirements. 
 
From the above example, RMTrak would recognize these requirements: 
 

RATM:VTP:1 The circuit shall be interrupted when the ground is shorted. 
{Test Method = I} {Test Pass = T} {Tester = QA} {Test Date = 5/17/00} 
[RATM:PRD:1] ¶ 

 
RATM:VTP:9 Inspection of the RATM unit shall show the use of a water proof 

seal. {Test Method = I} {Tester = HW} {Test Pass = T} {Test Date = 
5/17/00} [RATM:PRD:2] ¶ 
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RATM:VTP:10 Unit shall be tested with Multimeter to verify the fuses are in 
series and of the rated value. {Test Method = T} {Tester = QA} {Test Pass = T} 
{Test Date = 5/17/00} [RATM:PRD:5] ¶ 

 

i Tip: RMTrak reads table cells one row at a time, from left to right. 

 

Requirements Description Across Multiple Table Cells 

 
A complication occurs if you try to place requirements description within separate cells but you 
don’t want RMTrak to ignore the text that’s in the separate cells. 
 
To do this, you’d need to change RMTrak to no longer recognize cell borders (or paragraph 
marks) as the end to requirements descriptions. You can do this by setting up RMTrak to 
recognize a special character as the primary requirements terminator. 
 
You can then use the special character to let RMTrak know where requirements description ends. 
 

Example: 
 

Test Setup Expected 
Result 

Actual 
Result 
 

Pass/Fail 
 

RATM:VTP:1 The circuit 
shall be interrupted 
when the ground is 
shorted.  
{Test Method = I}  
{Tester = QA} 
[RATM:PRD:1] 
 

GFI is used 
and trips 
when the 
ground is 
interrupted. 

~ 

Expected 
results were 
observed.   

{Test Pass = T} 
{Test Date = 
5/17/00} 

RATM:VTP:9 Inspection 
of the RATM unit shall 
show the use of a water 
proof seal.  
{Test Method = I}  
{Tester = HW} 
[RATM:PRD:2] 
 

Watertight 
box is used. 

~ 

Expected 
results were 
observed 

{Test Pass = T} 
{Test Date = 
5/17/00} 

RATM:VTP:10 Unit shall 
be tested with 
Multimeter to verify 
the fuses are in series 
and of the rated value.  
{Test Method = T}  
{Tester = QA} 
[RATM:PRD:5] 

Circuit will 
be open when 
fuses are not 
present and 
closed when 
fuses 
present. 

~ 

Expected 
results were 
observed 

{Test Pass = T} 
{Test Date = 
5/17/00} 

 

� Note: The special character in the above image (here, the ~ placed in the second column) tells RMTrak where 
to end requirements descriptions for the requirements in each row. 
 

From the above example, RMTrak would recognize these requirements: 
 

RATM:VTP:1 The circuit shall be interrupted when the ground is shorted. GFI 
is used and trips when the ground is interrupted. {Test Method = I} {Test 
Pass = T} {Tester = QA} {Test Date = 5/17/00} [RATM:PRD:1] ¶ 
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RATM:VTP:9 Inspection of the RATM unit shall show the use of a water proof 
seal. Watertight box is used. {Test Method = I} {Tester = HW} {Test Pass 
= T} {Test Date = 5/17/00} [RATM:PRD:2] ¶ 

 
RATM:VTP:10 Unit shall be tested with Multimeter to verify the fuses are in 

series and of the rated value. Circuit will be open when fuses are not 
present and closed when fuses present. {Test Method = T} {Tester = QA} 
{Test Pass = T} {Test Date = 5/17/00} [RATM:PRD:5] ¶ 

 
RMTrak would recognize the additional text occurring before the special symbol you chose (~ ), 
and would ignore any text occurring after it, but would still recognize the attributes at the end of 
the row. 
 
 

Mixing Requirements Terminators In Tables 

 
Because RMTrak recognizes the end of a requirement when it encounters a new one or when it 
reaches the end of a document, it’s easy to mix requirements terminators. This can be beneficial 
if you have requirements in which you want to use the cell border as a requirement terminator but 
some occurrences in which you do not. 
 
For example, if the ~ symbol were left out for RATM:VTP:9 (as shown below), RMTrak would still 
recognize its first paragraph (in the first cell) as being its requirements description. This is 
because it’s followed by a new requirement in the next row. 
 

Example: 
 

Test Setup Expected Result Actual Result Pass/Fail 
 

RATM:VTP:1 The circuit 
shall be interrupted when 
the ground is shorted.  
{Test Method = I}  
{Tester = QA} 
[RATM:PRD:1] 
 

GFI is used and 
trips when the 
ground is 

interrupted. ~ 

Expected 
results were 
observed.   

{Test Pass = T} 
{Test Date = 
5/17/00} 

RATM:VTP:9 Inspection of 
the RATM unit shall show 
the use of a water proof 
seal.  
{Test Method = I}  
{Tester = HW} 
[RATM:PRD:2] 
 

Watertight box 
is used.  

Expected 
results were 
observed 

{Test Pass = T} 
{Test Date = 
5/17/00} 

RATM:VTP:10 Unit shall be 
tested with Multimeter to 
verify the fuses are in 
series and of the rated 
value.   
{Test Method = T}  
{Tester = QA} 
[RATM:PRD:5] 

Circuit will be 
open when fuses 
are not present 
and closed when 
fuses present.  

~ 
 

Expected 
results were 
observed 

{Test Pass = T} 
{Test Date = 
5/17/00} 

 

� Note: The special character (here, the  ~ placed in the second column of the first and third row only) tells 
RMTrak where to end the requirements descriptions for RATM:VTP:1 and RATM:VTP:10 but not 
RATM:VTP:9. This leaves RMTrak to interpret RATM:VTP:9’s requirement description by first recognizing the 
beginning of RATM:VTP:10, and then backtracking to collect RATM:VTP:9’s first paragraph. 
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From the above example, RMTrak would recognize these requirements: 
 

RATM:VTP:1 The circuit shall be interrupted when the ground is shorted. GFI 
is used and trips when the ground is interrupted. {Test Method = I} {Test 
Pass = T} {Tester = QA} {Test Date = 5/17/00} [RATM:PRD:1] ¶ 

 
RATM:VTP:9 Inspection of the RATM unit shall show the use of a water proof 

seal. {Test Method = I} {Tester = HW} {Test Pass = T} {Test Date = 
5/17/00} [RATM:PRD:2] ¶ 

 
RATM:VTP:10 Unit shall be tested with Multimeter to verify the fuses are in 

series and of the rated value. Circuit will be open when fuses are not 
present and closed when fuses present. {Test Method = T} {Tester = QA} 
{Test Pass = T} {Test Date = 5/17/00} [RATM:PRD:5] ¶ 

 
Notice that the text for RATM:VTP:1 and RATM:VTP:10 both include the text from the second 
column, but RATM:VTP:9 does not.  
 
Similarly, if the ~ symbol were left out for RATM:VTP:10, RMTrak would still recognize its 
requirements description because the requirement was followed by the end of the document. 
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Once you've created your database, adjusted its settings, and created a Microsoft® Word 
Document, you'll be ready to import the document into RMTrak: 
 

1. Add the document to RMTrak using the New Document dialog, which is available by 
clicking New in the main Documents manager 
 

2. Add the document's properties. This can also be done from within the New Document 
Dialog. 
 

 
Should you need to ever edit the document's properties, you can do so at any time without re-
importing the document: use the Modify Document dialog, which is available by clicking 
Properties in the main Documents manager. 
 
Any time you make changes to your Microsoft® Word document, you can refresh the document in 
RMTrak without re-importing it: use the Refresh button in the main Documents manager. 
 

Adding Documents 
 
To add your document to the Document manager: 
 

Step 1: Click New. The New Document dialog will appear.  
 

 
New Document dialog 

 
 

The New Document Dialog allows you to import new documents and add its properties 
simultaneously. If you've configured RMTrak to recognize document numbers and revisions from 
your document properties or filenames, RMTrak will import all of the New Document dialog's 
information for you, with exception to Type, which you'll need to select. 
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The New Document dialog has these fields: 
 

Filename This is the document's filename and location. To import a file 
and retrieve its file filename, click the browse button  
(…) to the right of the field to bring up the Add Document 
dialog for locating files. If you change the location of the file 
after importing it into RMTrak, you'll need to open the 
Modify Document dialog and change its file location so 
RMTrak can still recognize the file location. Filenames are 
limited to 250 characters.  
 
The Filename field in the example above shows S:\. The 
path in this example uses a mapped drive. If you add 
documents to RMTrak and use mapped drives, remember 
that each person to use the RMTrak project will also need 
to have the same mapped drives. Although documents can 
be located anywhere, it is recommended you organize their 
folders within the same directory.  

 
�  Note: If documents are placed in the same directory as the database file 

(.tra), RMTrak will use relative path names and mapping will not be an 
issue. 
 

Title This is the name of the document. If you specified the revision in 
the document's properties, RMTrak will recognize it and place it in 
this field for you when you import the document through the 
Filename field above; otherwise, you can specify it here. 
Document titles are limited to 50 characters. 
 

Type You can use this drop-down menu to choose a document type. 
Available document types are determined in the Document Types 
manager available from the Setup menu. 
 

Number This is the document number. If you specified the number in the 
document's properties, RMTrak will recognize it and place it in this 
field for you when you import the document through the Filename 
field above; otherwise, you can specify it here. Document numbers 
must be valid integers (1, 2, 3, etc.).  
 

� Note: The Number field will not appear if None is chosen in the 
Documents Setup. 
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Revision This the document version number. Document types are 

determined in the Document Types manager available from the 
Setup menu. If you specified the version in the document's 
properties, RMTrak will recognize it and place it in this field for you 
when you import the document through the Filename field above; 
otherwise, you can specify it here. Document version numbers 
must be valid integers (1, 2, 3, etc.) or real numbers with up to two 
places to the right of the decimal (1.35, 2.63, 9.65, etc.).  
 

� Note: The Revision field will not appear if None is chosen in the 
Documents Setup. 
 

 

Step 2: Once the New document dialog is open, you can add your file by clicking the browse 
button (…) to the right of the Filename field. When you choose a file, RMTrak will read and 
display the document's filename and location in the Filename field and the document's title in 
the Title field.  
 

Step 3: If you have added the document's number and/or revision to the document's filename 
or document properties, and have selected the corresponding option from the Document 
Setup, these options will appear in the Number and Revision fields. The Number option and 
Revision fields will not appear if None is chosen in the Documents Setup.  
 

Step 4: When you are finished, click Done. 
 
Adding documents will affect the list of documents available in the Documents manager.  
 

Editing Documents Properties 
 
The Modify Document dialog allows you to modify the document's Path and document Type, 
while the Title, Number, and Revision fields are read-only (to change the Title, Number, or 
Revision, you'll need to re-import the document). 
 

Step 1: From the Documents manager, highlight the name of document then click Properties. 
The Modify Document dialog will appear. 
 

 
Modify Document dialog 

 
 

The Modify Document dialog allows you to edit a document's properties. 
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� Note: The Modify Document dialog will be helpful if you need to update a document's file location or 
document type. If RMTrak gets the Title, Number, or Revision from your document's properties or 
filename, please do not attempt to change these in RMTrak—make any changes to these items within 
Microsoft® Word. 

 
The Modify Document dialog has these fields: 
 

Filename This is the document's filename. RMTrak gets the filename from 
the location of the file you originally added. If you change the 
location of the file after adding it into RMTrak, you'll need to open 
the Modify Document dialog and change its file location so 
RMTrak can still recognize the file location. You can click the 
browse button (…) to the right of the field to bring up the Add 
Document dialog for locating files. Filenames are limited to 250 
characters.  
 
The Filename field in the example above shows S:\. The path in 
this example uses a mapped drive. If you add documents to 
RMTrak and use mapped drives, remember that each person to 
use the RMTrak project will also need to have the same mapped 
drives. Although documents can be located anywhere, it is 
recommended you organize their folders within the same 
directory.  
 

� Note: If documents are placed in the same directory as the database 
file (.tra), RMTrak will use relative path names and mapping will not be 
an issue.  
 

Title 
 

This is the name of the document. If you specified the revision in 
the document's properties or filename, RMTrak will recognize it 
and place it in this field for you when you add the document; 
otherwise, you can specify it here. Document titles are limited to 
50 characters. 
 

Type You can use this drop-down menu to specify your document's 
type. Available document types are determined in the Document 
Types manager available from the Setup menu. 
 

Number 
(Read-only) 

This is the document number. If you specified the number in the 
document's properties or filename, RMTrak will recognize it and 
place it in this field for you when you add the document. 
Document numbers must be valid integers (1, 2, 3, etc.).  
 

Revision 
(Read-only) 

This is the document version number. Document types are 
determined in the Document Types manager available from the 
Setup menu. If you specified the revision in the document's 
properties or filename, RMTrak will recognize it and place it in this 
field for you when you add the document. Document version 
numbers must be valid integers (1, 2, 3, etc.) or real numbers with 
up to two places to the right of the decimal (1.35, 2.63, 9.65, etc.). 

 

Step 2: Choose or type the correct information. When a document is added to or refreshed in 
the database, the entire document is scanned by the program and all of its requirements are 
placed within the New Document dialog fields. You can manually add any information that 
RMTrak did not read and display.  
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Step 3: When you are finished, click OK. 
 
 

If your document has changed its location, you can update RMTrak by clicking the browse 
button (…) to the right of the Filename field. When you choose a file, RMTrak will read and 
display the document's filename and location in the Filename field and the document's title in 
the Title field.  

 

� Note: If you've incremented your document to another version (for example, from version 1.2 to 
1.3), instead of refreshing the document, you'll need to modify its properties and change its file location. 

 

If you have added the document's number and/or revision to the document's filename or 
document properties, and have selected the corresponding option from the Document Setup, 
these options will appear in the Number and Revision fields. The Number option and Revision 
fields will not appear if None is chosen in the Documents Setup. 
 
If your document has not changed its location but you want to update RMTrak with a new title, 
number, or revision kept in the document's filename or Microsoft® Word style, you do not need to 
change its information in the Modify Document dialog. If you highlight the document in the 
Documents manager then click Refresh, RMTrak can refresh your document's properties with 
this new information. 
 
Adding documents will affect the list of documents available in the Documents manager. 
 

 

Refreshing Documents 
 
After modifying and saving a document in Microsoft® Word, you'll need to refresh it in your 
project's RMTrak database. In the Documents manager, documents that are displayed in red 
need to be refreshed.  
 
When you increment document versions (for example, from version 1.2 to 1.3), RMTrak will 
automatically recognize the new version and update its database with the new information—
provided the new file is kept in the same folder location as the previous version, and provided you 
have set up RMTrak to recognize document numbers and revisions. 
 

� Note: If you've incremented your document to another version and you have RMTrak set up not to recognize 
document numbers and revisions or keep the file in a new location, you'll need to manually modify its 
properties and/or change its file location. 

 
To refresh the document, select the document then click Refresh. RMTrak will open and scan the 
document. Any new or changed requirements will be updated in your project's RMTrak database.  
 
When a document is refreshed in the database, the program scans the entire document and all of 
its requirements are placed within the New Document dialog fields. You can manually add any 
information that RMTrak did not read and display.  
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If RMTrak discovers that a requirement has changed, it will mark all of its children requirements 
as suspect. This allows you to create Suspect reports to quickly find out about any other 
requirements that might have been affected by the change, so you can change them too, if 
necessary. 
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Document Status and 
Relationships 
Working with Views 

 
To work with and create views, you’ll need to use the View Dialog and the View Manager. This 
topic discusses both. 
 
 
View Dialog 
 
The View Dialog, which is available by choosing New from the View menu, shows the different 
views available and lets you create new views. Views let you organize requirements in different 
ways so you can better understand their relationships, attributes, and status. 
 

 
View Dialog showing Tree tab 

 
The View dialog has these buttons: 
 

OK Once you have highlighted the document and attributes (if 
available) you want to use in your view, clicking OK will 
create the view. 
 

Cancel Clicking this button will close the View dialog. 
 
 
The parts of the window will depend on which tabs you've clicked. 
 
 

Tree Tab 
 
Click Tree in the View dialog to display the options for creating a Tree view. 
 



 RMTrak™ Requirements Management Tool User Manual © 2002 RBC Product Development http://www.RMTrak.com 86 

 
View Dialog showing Tree tab 

 
 

Documents This is a list of all documents that have been 
imported into the project’s database. 

 
Select a document name (then click OK) to create a Tree view showing that document’s 
requirements. 
 
 
 
Matrix Tab 
 
Click Matrix in the View dialog to display the options for creating a Matrix view. 
 

 
View Dialog showing Matrix tab 

 
 

Documents This is a list of all documents that have been 
imported into the project’s database. 
 

Attributes This is a list of Enum (Single) and Enum (Multiple) 
attributes available with this project. You can alter 
this list from the Attributes Manager. Your documents 
might not have any/all these attributes in their 
documents. 

 
Select a document name and any attributes (then click OK) to create a Matrix view 
showing that document’s requirements.  
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i Tip: Press CTRL or SHIFT as you select to select multiple attributes. 
 
 
 
Allocation Tab  
 
Click Allocation in the View dialog to display the options for creating an Allocation view. 
 

 
View Dialog showing Allocation tab 

 
 

Documents This is a list of all documents that have been 
imported into the project’s database. 
 

Attributes This is a list of attributes available with this project. 
You can alter this list from the Attributes Manager. 
Your documents might not have any/all these 
attributes in their documents. 

 
Select an attribute and any documents (then click OK) to create a Allocation view 
showing how that attribute is allocated within the document. 
 

 
 
 

SQL Tab  
 
Click SQL in the View dialog to display the window for typing SQL commands. 
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View Dialog showing SQL tab 

 
 

Blank 
window 

You can type your SQL commands in this window. 
Click OK to generate your query. 

 
Type your SQL command in the window (then click OK) to create an SQL view showing 
your results. 

 
 
The View Manager 
 
Once you've created a view, you can save your views, open saved views, and delete views using 
the View manager. When you open, save, or delete a view, the View manager opens and lists 
your saved views. 
 
The View Manager appears when you select the Save As, Open, or Delete options from the 
View menu. 
 

 
View Manager 

 
The View manager has these buttons: 
 

OK Saves, deletes, or opens a view, depending on your previous 
actions. 
 

Cancel Cancels saving, deleting, or opening a view. 
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Creating New Views 
 
RMTrak's View manager lets you create new Tree, Matrix, or Allocation, or SQL views:  
 

1. From the Views menu, choose New.  
The View dialog will appear. 

 

 
View dialog showing Tree tab 

 
2. In the appropriate tab, select a document and its attributes (if available). 

 
3. Click OK.  

 
4. If a message appears saying "Trace table is out of date. Do you want to rebuild it?" click 

Yes. 
 

 
For information particular to creating each view, see these topics: 
 

• Tree View 
• Matrix View 
• Allocation View 
• SQL View 

 

Tree View 
 
A Tree view provides a means of viewing the hierarchical relationship between parent/child 
requirements in a tree-like structure.  
 

i Tip: You can see this view in a tabular format by creating a Trace Report. 
 

To create a Tree view: 
 

1. From the Views menu, choose New.  
The Tree tab will appear. 
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View Dialog showing Tree tab 

 
 

2. In the Tree tab, select a document.  
 

3. Click OK.  
 

4. If a message appears saying "Trace table is out of date. Do you want to rebuild it?" click 
Yes. 
 

 
The tree view displays your document's requirements. Requirements that have a plus (+) sign by 
their name have hidden sub-requirements. 
 

 
Tree View with collapsed requirements 

 
 
To reveal these sub-requirements, click the plus sign (+). Similarly, to hide these sub-
requirements, clicking the minus (-) sign.  
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Tree View with expanded requirements 

 
 
If you double-click on a tag in this view, it will bring up its properties. 
 

 
Tree View showing properties of RATM:VTP:1 tag 

 
 
This window has these buttons: 
 

Goto Clicking this button will open your Microsoft® Word document and 
go to this tag. 
 

History Clicking this button will show your tag's creation/modification 
history.  
 

Suspect If your requirement is Suspect, clicking this button will clear the 
requirement of being "suspect" in the database. You should only 
clear a requirement of being suspect if you have verified the 
requirement is still correct. 

 

  Warning: If you rely on the information provided with the History feature, you might want to 
periodically save your database to a different name (leaving the previous named version as a 
"backup" copy). Otherwise, should you lose the database, the History information would also be lost. 
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If you select the History button, the tag's creation/modification history will display. 
 

 
Tree View showing History of RATM:VTP:1 tag 

 
 

� Note: The creation/modification history shown in a Tree View shows when requirements were created or 
modified in your project's RMTrak database, not when they were created/modified in the document. 

 

Matrix View 
 
The Matrix view shows the relationships between requirements and their selected attributes.  
 
To create a Matrix view:  
 

1. From the Views menu, choose New.  
 

2. Select the Matrix tab.  
 

 
View Dialog showing Matrix tab 
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3. In the Documents pane, select a document. In the Attributes pane, click the attributes 
you want to see.  
 
You can select multiple attributes by pressing the CTRL or SHIFT key as you select 
attributes.  
 

4. When you are finished, click OK.  
 

5. If a message appears saying "Trace table is out of date. Do you want to rebuild it?" click 
Yes. 
 

 
RMTrak will build a view that displays the tags and their attributes for the document and attributes 
you selected. 
 

 
Matrix View for RATM Testing Specifications document and all attributes 

 
 

In the Matrix view, each row of the table represents a separate requirement and each column 
represents a particular attribute.  
 

i Tip: You can sort each column in the Matrix view by clicking its column header. 
 

 

Allocation View 
 
The Allocation view displays which values are assigned to your requirements’ attributes.  
 

� Note: Attributes show the status of a requirement. RMTrak's attributes are defined using the Attributes 
manager. 

 
 

Creating an Allocation view 
 
To create an Allocation view: 
 

1. From the Views menu, choose New.  
 

2. Select the Allocation tab.  
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View Dialog showing Allocation tab 

 
 

3. In the Documents pane, select a document. In the Attributes pane, click the attribute 
you want to see.  
 

4. If a message appears saying "Trace table is out of date. Do you want to rebuild it?" click 
Yes. 

 

 
Allocation View 

 
 
 
When an Allocation view is created, each row in the view represents an individual requirement, 
and each column represents the possible values the attribute can have. An X in a cell indicates 
the requirement's attribute is associated with that particular value. If the views says (READ-
ONLY) at the top, this is because the attribute is not Persistent. Persistence can be adjusted in 
the Attribute Edit dialog. 
 
 
Using the Allocation View to Manage Values 
 
If the attribute has the following settings (set within the Attributes manager), you can use the 
Allocation view to change, or allocate, the values assigned to each requirement in the document.  

 
• The attribute’s Type is set to Enum (Single) or Enum (Multiple) 

 
• The attribute’s Rule lists the possible values of the attribute, separated by semicolons (;) 
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• The attribute’s Persistent checkbox is checked  
 

� Note: This step is crucial—checking the Persistent checkbox lets the attribute be controlled from the Allocation 
view rather than from the document. 

 
The ability to allocate a requirement’s values within the Allocation view eliminates the need to 
assign the attributes to the requirement from within the document by using tagged attributes. 

 
The ability to change the attributes in the Allocation view differs by whether Enum (Single) or 
Enum (Multiple) is chosen in the Attributes manager: 

 
• If the attribute’s Type is set to Enum (Single), you can assign a requirement one of all of 

the attribute’s possible values from those listed within the Rules field.  
 
For example, if the attribute’s Type is Enum (Single) and the Rule is set to HW;QA;SW, 
you can assign a requirement using that attribute the value HW or QA or SW. You may 
only choose one of these values to apply to your requirement. 
 

• If the attribute’s Type is set to Enum (Multiple), you can assign a requirement any/all of 
the attribute’s possible values from those listed within the Rules field.   
 
For example, if the attribute’s Type is Enum (Multiple) and the Rule is set to 
HW;QA;SW, the attribute’s value (listed within the document or the Allocation view) can 
be HW, QA and/or SW, or any combination of choices. 

 
 

 Warning: If you use Persistent attributes, you might want to periodically save your database to a 
different name (leaving the previous named version as a "backup" copy). Otherwise, should you lose 
the database, the information you stored in it would also be lost. If you want to retain RMTrak's 
document-centric benefit of leaving important information in the documents rather than in the 
database, do not use persistent attributes. 

 
Changing the Values Of Persistent Attributes within the Allocation View 
 
To change a requirement’s Persistent attribute values from within the Allocation view, simply 
double-click the correct cell. Depending on whether the attribute’s values were set to Enum 
(Single) or Enum (Multiple), you may or may not be able to select multiple values for the 
requirement. 
 

� Notes: If an attribute is Persistent, you will not need to add this attribute's values to your tags. 
 
Changes made within the Allocation view are automatically saved when the Allocation view window is closed. 

 
 
Saving Views and Opening Saved Views 
 

To save this view, while the view window is open, from the Views menu, choose Save as. Type 
a name for the view then click OK.  

 

You can then view your saved view by choosing Open from the View menu. When you open a 
saved view, RMTrak updates the information from the documents, provided they have have 
been refreshed in the main Documents manager. 
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SQL View 
 
A SQL (Structured Query Language) view is similar to a matrix view except that the table is 
defined using an SQL String. This allows you to access any field in the database quickly and 
easily. 
 
SQL is a syntax that is used to retrieve information from a database. If you are familiar with SQL, 
you can create SQL queries by clicking the Views menu, choosing New, then selecting the SQL 
tab.  
 

 
View Dialog showing SQL tab 

 
 
To enter SQL commands, type your SQL commands in this window then click OK. For 
information on SQL syntax, see the SQL Syntax topic, available in RMTrak's online help files, 
which can be accessed through RMTrak's Help menu.  
 

 
View Dialog showing SQL tab with typed command 

 
 
When you click OK, your query's results will show in the SQL View window. 
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SQL View 

 
 

i Tip: You can sort each column in the Matrix view by clicking its column header. 
 
To learn more about the SQL View and RMTrak's database schema, please consult RMTrak's 
online help files available from RMTrak's Help menu. 

 

 

Saving Views 
 
RMTrak's View manager lets you save views:  
 

1. While the view window is open, from the Views menu, choose Save as.  
The View Manager will appear. 

 

 
View Manager 

 
 
2. Type a name for the view then click OK.  

 
Saved views are available to all users of the RMTrak project. 
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Opening Saved Views 
 
RMTrak's View manager lets you view your saved views: 
 

1. From the View menu, choose Open.  
The View Manager will appear. 

 

 
View Manager 

 
2. Choose the document you want to open then click OK. 

 
 
When you open a saved view, RMTrak updates the information from the documents, provided 
they have been refreshed in the main Documents manager. 
 

 

Deleting Views 
 
RMTrak's View manager lets you delete a saved view: 
 

1. While the view window is open, from the Views menu, choose Delete.  
The View Manager will appear. 
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View Manager 

 

 
2. Highlight the name of the view you want to delete then click OK.  

 
3. Click Yes. 
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To create a report, from the Reports menu, select the report you want to create. For more specific 
information pertaining to each type of report, please choose one of the following topics: 
 

• Change Reports 
• Childless Requirements Reports 
• Closure Reports  
• Orphan Requirements Reports 
• Requirements Summary Reports  
• Suspect Reports  
• Trace Reports  
• Unallocated Requirements Reports 

 
You can choose whether RMTrak generates reports in HTML or Microsoft® Word format. 
 

Orphans Reports 
 
Orphan Reports are used to identify any orphan requirements in your RMTrak project. 
 
As projects progress, a document's requirements will change status as they are tested, validated, 
verified, and closed. As a requirement's status is updated in each document, the next document's 
status of that requirement, or "children" requirement, is traced back to its previous document's 
predecessor, or "parent" requirement. In this way, requirements and their status have parent-child 
relationships.  
 
An orphan requirement is requirement that lists a parent requirement that doesn't exist in the 
RMTrak database.  
 
For example, the child/defined requirement below lists the parent requirement [RATM:PRD:11]. 
 

RATM:VTR:11 The circuit shall be interrupted when the ground is shorted.  
{Test Method = I} [RATM:PRD:11]¶ 
 

However, if RATM:PRD:11 doesn't actually exist anywhere but here, as a "parent" reference, 
RMTrak will mark this requirement as an orphan (meaning its parent doesn't actually exist). 
 
If a requirement is an orphan, this might be because: 
 

Cause of Orphans Fix 
 

1)   The document containing the 
parent requirement has not been 
loaded into the database.  
 

Make sure you've imported all your 
documents into RMTrak. 
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2)   There is a typo in either the 

parent tag or the defined/child 
tag. 
 

Create an Orphans Report to see which 
requirements are orphans, then 
manually fix the problem in your 
documents.  

 
You can determine if your project has orphan requirements by creating an Orphans Report.  
 
 
Creating Orphan Reports 
 
To create an Orphan Report: 
 

1. From the Reports menu, choose Orphans.  
 

2. If a message asks "The orphans table is out of date. Do you want to rebuild it?" Click 
Yes.  
The Orphans Requirements manager will appear and list all of your project's orphan 
requirements.  

 

 
Orphans Requirements manager 

 
 
If you double-click an orphan requirement in this list, a window will appear showing your 
requirement's properties. 
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Orphans Report showing RATM:PRD:10 properties 
 

 
This window has these buttons: 
 

Goto Clicking this button will open your Microsoft® Word document and go 
to this tag. 
 

History Clicking this button will show your tag's creation/modification history. 
 

Suspect If your requirement is Suspect, clicking this button will clear the 
requirement of being "suspect" in the database. You should only 
clear a requirement of being suspect if you have verified the 
requirement is still correct. 
 

 

 Warning: If you rely on the information provided with the History feature, you might want to 
periodically save your database to a different name (leaving the previous named version as a 
"backup" copy). Otherwise, should you lose the database, the History information would also be lost. 

 
If you select the History button, the requirement's creation/modification history will display. 
 

 
Orphans Report showing RATM:PRD:10 creation/modification history 

 
 

� Note: The creation/modification history shown in an Orphan Report shows when requirements were created 
or modified in your project's RMTrak database, not when they were created/modified in the document. 

 

Childless Reports 
 
A childless requirement is a child requirement that has no requirements tracing back to it and is 
not contained in a terminal document.  
 
If a requirement is childless, this might be because: 
 

Cause of Childlessness 
 

Fix 
 

1)   The document containing the child 
requirement has not been imported 
into the database. 

Make sure you've imported all your 
documents into RMTrak. 
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2)   You have incorrectly misidentified or 

misspelled the requirement in its 
parent document. 
 

If your development team has 
forgotten or neglected a requirement, 
your final project will not fulfill all of its 
initial requirements. To fix this 
problem, create a Childless Report to 
see which document the requirement 
was last included in, then edit the 
next document in your project's 
hierarchy to include the requirement.  

 
You can determine if your project has childless requirements that are not supposed to be 
childless (because further action is necessary) by running a Childless Report. RMTrak will display 
every requirement that is not part of a terminal document. For this reason, you should create a 
Childless Report. After importing each document. This will keep your development team from 
missing any requirements as it moves along the development process. 
 
 
Creating Childless Reports 
 
To create a Childless Report: 
 

1. From the Reports menu, choose Childless.  
 

2. If a message asks "The childless table is out of date. Do you want to rebuild it?" Click 
Yes.  
The Childless Requirements manager will appear and list all of your project's childless 
requirements.  

 

 
Childless Requirements manager 

 
 
If you double-click a childless requirement in this list, a window will appear showing your 
requirement's properties. 
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Childless Report showing RATM:PRD:11 properties 

 
 
This window has these buttons: 
 

Goto Clicking this button will open your Microsoft® Word document and go 
to this tag. 
 

History Clicking this button will show your tag's creation/modification history. 
 

Suspect If your requirement is Suspect, clicking this button will clear the 
requirement of being "suspect" in the database. You should only 
clear a requirement of being suspect if you have verified the 
requirement is still correct. 
 

 

 Warning: If you rely on the information provided with the History feature, you might want to 
periodically save your database to a different name (leaving the previous named version as a 
"backup" copy). Otherwise, should you lose the database, the History information would also be lost. 

 
If you select the History button, the requirement's creation/modification history will display. 
 

 
Childless Report showing RATM:PRD:11 creation/modification history 
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� Note: The creation/modification history shown in a Childless Report shows when requirements were created 
or modified in your project's RMTrak database, not when they were created/modified in the document. 

 
 
 

Suspect Reports 
 
Suspect requirements are requirements whose parent requirement has changed.   
 
 
How a Changed Parent Requirement Makes Its Children Requirements Become Suspects 
 
If you modify or change a parent requirement, the child requirements might also need to be 
modified. For example, if a requirement in the Product Requirements Document says: 
 

Internal temperature control shall be activated if  
temperature rise is >15 degrees ambient. 
 

you might determine late in the project that this is incorrect and change it to: 
 

Internal temperature control shall be activated if  
temperature rise is >16 degrees ambient. 
 

Unfortunately, this will make later requirements, such as one in the Product Validation Testing 
Procedures, inaccurate: 
 

When temperature is increased by 15 degrees above the  
ambient, the system will shut down. 

 
If your project has thousands of requirements, this one could easily be overlooked, and you could 
forget to change this one to match the new number 16. 
 
RMTrak helps you keep track of this type of problem by marking the children of changed 
requirements as "suspect." RMTrak does this to ensure that you are aware of the modifications 
and review each child requirement carefully to see if they also need changing.  
 
 
Finding Suspect Requirements 
 
There are two ways to find and view suspect requirements in RMTrak: 
 

• Create a Suspect Report to view a list of all suspect requirements. 
 

• Create a Tree view, Orphan Report,Childless Report,, or Unallocated Report. Suspect 
requirements will be designated with an S symbol. If you double-click the suspect 
requirement, a window will open showing its properties. Click Suspect to remove the 
tag's suspect status. 
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You should create a Suspect Report after modifying it then refreshing it in RMTrak to see if any 
parent tags have changed. If any parent tags have changed, RMTrak will list them in its Suspect 
Report; you should then find the parent tags in the document and ensure that they have not been 
incorrectly or unnecessarily modified.  
 
 
Creating a Suspect Report 
 
To create a Suspect Report: 
 

1. From the Reports menu, choose Suspect. 
 

2. If a message asks "The suspect table is out of date. Do you want to rebuild it?" Click Yes.  
 

3. If any documents have suspect requirements, they will be listed in the Suspect 
Requirements manager.  

 

 
Suspect Requirements manager 

 
 
If you double-click an suspect requirement in this list, a window will appear showing your 
requirement's properties. 
 

 
Suspect Report showing RATM:VTP:4 properties 
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This window has these buttons: 
 

Goto Clicking this button will open your Microsoft® Word document and go 
to this tag. 
 

History Clicking this button will show your tag's creation/modification history. 
 

Suspect If your requirement is Suspect, clicking this button will clear the 
requirement of being "suspect" in the database. You should only 
clear a requirement of being suspect if you have verified the 
requirement is still correct. 

 

 Warning: If you rely on the information provided with the History feature, you might want to 
periodically save your database to a different name (leaving the previous named version as a 
"backup" copy). Otherwise, should you lose the database, the History information would also be lost. 

 
If you select the History button, the requirement's creation/modification history will display. 
 

 
Suspect Report showing RATM:VTP:4 creation/modification history 

 
 

� Note: The creation/modification history shown in a Suspect Report shows when requirements were created or 
modified in your project's RMTrak database, not when they were created/modified in the document. 

 
 
Removing the "Suspect" Status from the Requirement 
 
Once you have ensured that the "suspect" requirement in question was correctly and necessarily 
modified, you can let RMTrak know to update its database of the new, correct parent tag by 
simply highlighting the document in the main Documents manager then clicking the Refresh 
button. 
 
You can also create a Tree view. Suspect requirements are designated with the letter s in the 
Tree view. If you double-click the suspect requirement in the Tree View, a window will open 
showing its properties. Click the Suspect button to remove the tag's suspect status. 
 

 Warning: If you have a report or view open, removing a requirement’s suspect status will not update 
the report or view. To see an updated report or view, you will need to re-create it. 
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Unallocated Reports 
 
When you add attributes to the Attributes manager, which is available from the Setup menu, you 
give it a name, a data type, and a rule. If you've chosen the data type Enum (Single) or Enum 
(Multiple), the attribute's rule will consist of a list of values that you can apply to the requirement 
in its tag. 
 
When you put the attribute and its tags around the requirement in its document, you also list the 
value. For example, in the following example, the attribute {Test Method = I} has the value I; 
however, this value could have been I, A, D, or T (Inspection, Analysis, Detection, or Test) since 
I;A;D;T is listed as this attribute's rule (in the Attributes manager). 
 

RATM:PVTR:1 The circuit shall be interrupted when the  
ground is shorted. {Test Method = I} [RATM:PRD:1]¶ 
 

If you neglect to give the attribute its related value, as in the following example, RMTrak will 
notice this and consider it an "unallocated requirement." 
 

RATM:PVTR:1 The circuit shall be interrupted when the  
ground is shorted. {Test Method} [RATM:PRD:1]¶ 
 
 

Because the test method above doesn't specify which test method it used (I, A, D, or T), its test 
method is missing, or this requirement has an unallocated attribute. If this requirement has an 
unallocated attribute, its requirement will also be unallocated. 
 
RMTrak will also consider any requirement that does not have an attribute applied to be an 
unallocated requirement. For example, in the following requirement's tags, no attribute is listed. 
This requirement is therefore considered "unallocated." 
 

RATM:PVTR:1 The circuit shall be interrupted when the  
ground is shorted. [RATM:PRD:1]¶ 
 
 

You should create an Unallocated Requirements Report after adding each document. RMTrak 
can then help you determine if you've neglected to add attributes to a requirement or values to an 
attribute. 
 
 
Creating an Unallocated Requirements Report 
 
To create an Unallocated Requirements Report: 
 

1. From the Reports menu, choose Unallocated.  
 

2. If a message asks "The unallocated table is out of date. Do you want to rebuild it?" Click 
Yes. 
The Unallocated Requirements Dialog will appear.  
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Unallocated Requirements Dialog 

 
 

3. In the Documents pane, select a document.  
 

4. In the Attributes pane, select an attribute.  
 

5. Click OK.  
RMTrak will generate a list of the attribute for that document and any matching 
unallocated requirements.  

 

 
Unallocated Requirements 

 
 
If you double-click an unallocated requirement in this list, a window will appear showing your 
requirement's properties. 
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Unallocated Report showing RATM:SHA:1 properties 

 
 
This window has these buttons: 
 

Goto Clicking this button will open your Microsoft® Word document and 
go to this tag. 
 

History Clicking this button will show your tag's creation/modification 
history. 
 

Suspect If your requirement is Suspect, clicking this button will clear the 
requirement of being "suspect" in the database. You should only 
clear a requirement of being suspect if you have verified the 
requirement is still correct. 
 

 

 Warning: If you rely on the information provided with the History feature, you might want to 
periodically save your database to a different name (leaving the previous named version as a 
"backup" copy). Otherwise, should you lose the database, the History information would also be lost. 

 
If you select the History button, the requirement's creation/modification history will display. 
 

 
Unallocated Report showing RATM:SHA:1 creation/modification history 
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� Note: The creation/modification history shown in an Unallocated Report shows when requirements were 
created or modified in your project's RMTrak database, not when they were created/modified in the document. 

 

 

Requirements Summary 
 
A Requirements Summary Report shows a requirement’s text associated with all of its derived 
requirements' text. This is helpful for reviewing your project's tracing of a requirement and all of its 
derivatives.  
 
A Requirements Summary Report shows how a requirement is related to all of its child 
requirements. With the Requirements Summary report, you can follow the traceability of the 
requirements from a broad level to specific testing results. Such traceability is important when 
reviewing a solution to ensure it is correct and complete.  
 
The Requirements Summary Report is also useful for making sure all of your child requirements 
match the scope and function of their parents.  
 
For example, the flow chart below shows how requirements and how they relate to each other. 
 

 
 

 
This project's Summary Report, which is created for two documents at a time (or one parent-child 
level), would have this information for the CRD and PRD documents: 

 
Requirements Summary Report 
 
RATM:CRD:1 Circuit shall be designed to minimize impact of faulty ground. 
RATM:PRD:1 GFI shall be included in hardware. 
RATM:CRD:2 System shall prevent moisture from entering environment. 
RATM:PRD:2 Watertight box shall be used. 
RATM:CRD:3 Damage to the unit shall be detected by regular inspection. 
RATM:PRD:3 Periodic maintenance shall be required. 
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Creating Requirements Summary Reports 
 
To create a Requirements Summary Report: 
 

1. From the Reports menu, choose Requirements Summary.  
The Requirements Summary dialog will appear.  

 

 
Requirements Summary dialog 

 
 
2. In the Parent pane, select the document of a parent tag.  

 
3. In the Child pane, select the document of a child tag (if available).  

 
4. When you're finished, click OK.  

RMTrak will generate a Requirements Summary report. 
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Requirements Summary Report 
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Closure Report 
 
RMTrak can create reports to show you your project's closed requirements. 
 
A Closure Report shows the closure status of the requirements contained in a document. A 
requirement is considered closed if all the tests that trace, directly or indirectly, back to it have 
passed.  
 
For example, in the requirements below, you can see that the RATM:VTR:1, RATM:VTR:3, and 
RATM:VTR:5 requirements have passed their tests, but RATM:VTR:2 and RATM:VTR:4 
requirements have not. 
 

 
 

 
Additionally, because parent requirements are closed when their children are closed, in the above 
example, the RATM:CRD:1, RATM:PRD:1, RATM:CRD:3, RATM:PRD:3, and RATM:PRD:5 
requirements would also be closed.  
 
The following diagram illustrates this closure relationship (where red requirements are closed and 
black requirements are still open; arrows show direction of parent-child relationship). 
 

 
 

 
You should create a Closure Report after adding each document, especially toward the end of 
your project. You can then see which requirements have been completed and which ones are still 
"open." 
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Parent-Child Closures 
 
In addition to closed requirements, if a parent requirement’s children are each found to be closed, 
the parent requirement will also be shown as closed.  

 

 Warning: Make sure all of your project’s documents have been imported into the RMTrak project. 
RMTrak cannot recognize requirements of documents that have not been imported. If a parent 
requirement has an open child requirement listed within a document that has not been imported, 
RMTrak might still list the parent requirement as closed (if the children requirements of the 
imported documents are closed). 

 
Creating Closure Reports 
 
To create a Closure Report: 
 

1. From the Reports menu, choose Closure Report.  
 

2. If a message asks "The closure table is out of date. Do you want to rebuild it?" Click Yes. 
The Closure Report dialog will appear.  
 

 
Closure Report dialog 

 
 
3. Select a document. From the drop-down lists, select which types and names of attributes 

RMTrak should check for when creating a closure report.   
 

i Tips: Selecting <None> tells RMTrak that it should not include that attribute type in closure reports, 
and/or your requirements do not use that type of attributes.  
 
If selecting an attribute (anything other than <None>), be sure to select the correct attribute for its type. 
For example, if your organization uses a customized test method attribute called "Method," be sure to 
select Method in the Test Method Attribute drop-down list (and not in any other drop-down list).  

 
Documents using RMTrak’s default attributes may have the following selections. 

 
• Ownership Attribute: Tester or  <None> 
• Test Status Attribute: Test Status or  <None> 
• Test Method Attribute: Test Method or  <None> 
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• Test Date Attribute: Test Date or  <None> 
 
4. When you’ve finished, click OK. 

RMTrak will generate a read-only report in Microsoft® Word of the requirements and 
show you which requirements are closed and which ones are still open.  

 

 
Closure Report 

 
 
Closure Reports will be especially helpful toward the end of a project when you need to determine 
which requirements have not yet passed their tests successfully. 
 

 

Change Reports 
 
The Change Report allows you to view the attribute and requirement changes and the 
requirement creations and deletions that have occurred within the database. 
 
Step 1: To create a Change Report, from the Reports menu, choose Change Report. The 
Change Report dialog will appear.  
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Change Report dialog 

 
The Change Report dialog has these fields: 
 

Document 
Types 

A list of the document types available for this project. This list can 
be altered in RMTrak's Document Types manager. 
 
 

Documents A list of imported documents. 
 

Change 
Types 

Types of change you want to focus on for your report: Feature 
Change, Requirement Change, Requirement Change, 
Requirement Creation, Requirement Deletion. 
 

Date The date you'd like to specify for the report: All, Since, Before, 
Between. If you select Since, Before, or Between, fields will 
appear so you can type the dates. 

 
Step 2: Select the document types, documents, and change types you want to use in the report. 
You can select multiple items by pressing CTRL or SHIFT as you select items. RMTrak, by 
default, has all items selected. 
 
Step 3: Choose date(s) you'd like to focus on for your report.  
 
Step 4: When you are finished, click OK. RMTrak will generate a read-only report of changes that 
have occurred with the document's requirements. 
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Change Report 

 
 
 

Trace Report 
 
RMTrak can create reports to show you your project's requirements tracing. 
 
A Trace Report shows you how one document’s requirements traced from other, previous 
document’s requirements. 
 

i Tip: You can also view  requirements tracing in the Tree View. 
 
 
Creating Trace Reports 
 
To create a Trace Report: 
 

1. From the Reports menu, choose Trace Report.  
 

2. If a message asks "The closure table is out of date. Do you want to rebuild it?" Click Yes. 
The Trace Report dialog will appear.  
 

 
Trace Report dialog 
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3. Select the document(s) you want to trace requirements for. You can select multiple 
documents by pressing CTRL or SHIFT as you select. RMTrak, by default, selects all 
documents for you. 
 

4. When you’ve finished, click OK. 
RMTrak will generate a read-only report in Microsoft® Word that shows which 
requirements trace from other, previous requirements. 

 

 
Trace Report 

 
 

Printing Reports 
To print a report, when the report window is open, from the File menu choose Print or Print to 
File. This method works for both HTML and Microsoft® Word output formats. 
 

Adding In Reports 
 
If your company desires custom reports, contact RBC Product Development For more help on 
using the Report Manager, please see the online help system available from RMTrak's Help 
menu. 
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What Are Requirements? 
  
Requirements are statements made about a product/project’s  
requirements.  
 
For example, the statement "The circuit shall be interrupted  
when the ground is shorted" is a requirement about a  
product’s circuit.  
 
The goal of RMTrak is to recognize your document’s  
requirements, trace their position in your documentation and  
relationship to other requirements, and to track their status— 
such as who’s working on the requirement, how and when  
they’re testing it, and whether it has passed its tests.  
 
 

What Are Tags? 
 
When you import documents into RMTrak, RMTrak recognizes  
the documents’ requirements by the tags you put around each  
requirement.  
 
There are different types of tags.  

• Initial tags (also called "child" tags) are placed at the  
beginning of requirements and can consist of any  
unique, memorable set of letters or numbers.  

• Parent tags are brackets ( [ ] ) enclosing the initial tag  
of the requirement in a previous document that led to  
this requirement. 

 

What Are Attributes? 

Attributes track information about a requirement, such as who  
tested it, when they tested it, and more. By placing attributes  
with a requirement, RMTrak can help you track this information  
about each requirement, and help you easily generate status  
reports.  
 
For example, the {Test Method = I} in the following requirement  
is an attribute (showing that the requirement was tested with  
the I (Inspection) test method: 
 

RATM:PVTR:1 The circuit shall be interrupted  
when the ground is shorted.  
{Test Method = I} ¶ 
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How Does RMTrak Recognize Tags? 

RMTrak recognize tags based on their syntax and based on any  
properties you configured in the project setup, which is available  
by choosing Options from the Setup menu.  
 
 
How Does RMTrak Recognize Requirements? 

When you import documents into RMTrak, RMTrak recognizes the  
beginning of a requirement by the initial tag preceding it. 
 
RMTrak recognizes the end of a requirement when it encounters: 

• A requirements terminator. Requirements terminators  
can be the end of a paragraph (¶) or a character you  
specify in RMTrak’s project settings 

• The start of a new requirement (signaled by another  
initial tag) 

• The end of the document 
When RMTrak encounters one of the above, it knows the  
requirement is complete, and then it backtracks to find the  
requirement’s description, attributes, and parent tag(s), if available. 
 
 
How Does RMTrak Recognize Attributes? 
 
RMTrak recognizes attributes by the brackets placed  
around them ( [ ] ). As long as an attribute is located  
somewhere after the initial tag, and somewhere before  
the next requirement’s initial tag, RMTrak will find the  
attribute and associate it with the its requirement. 
 
 
What Are Paragraph Marks? 
 
A paragraph mark (¶), which is also called a "hard carriage return," can 
be created by pressing ENTER on your keyboard.  
 
You can a line break ( ), also called a "soft carriage return" by 
pressing SHIFT + ENTER on your keyboard. (If your document uses a 
paragraph mark as a tag terminator, you'll need to use line breaks 
frequently within tags and requirements.) 
 
To see paragraph symbols, you'll need to make sure Microsoft® Word 
has the paragraph marks option turned on:  
 

1. In Microsoft® Word, from the Tools menu, choose Options.  
2. Click the View tab.  
3. In the Formatting Marks section, check the Paragraph marks 

check box.  
4. Click OK.  
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